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MYOB Software Licence Agreement 

IMPORTANT‐READ THIS CAREFULLY BEFORE USE. This is the Software Licence Agreement 
(Agreement). As you have purchased the Product (consisting of the User Documentation and 
the installation CD or other media containing the Software), following notification of the 
Licence you are now legally bound by its conditions. 

HOWEVER, if the Licence Agreement contains anything of which you were not aware prior to 
purchasing the Product or do not agree to be bound by, DO NOT INSTALL THE SOFTWARE but 
return the Product to the reseller in its entirety and a full refund of the purchase price will be 
made. By installing the Software and keeping the Product you are confirming that you have 
purchased the Product subject to this Licence and are bound by its provisions. 

TRIAL VERSION SOFTWARE LIMITATION. If you use this Software on a trial basis prior to 
purchase, then additional restrictions govern its use. The Trial Version is intended to be used 
only for evaluation purposes and whilst you may create your own company data files 
("Company Files") you will have access to your Company Files only for a period of 90 days 
from the date of creation of each Company File. 

Thereafter, you will be able to access the Company Files created by you only upon your 
purchase of the full version of the Software product licence. Upon your purchase of the full 
version of the Software product licence, the restrictions in this paragraph (Trial Version 
Software Limitation) shall no longer apply, but you acknowledge that your use of the full 
version of the Software product licence will be conditioned on your agreeing to the terms of 
the Software Licence Agreement accompanying the full version of the Software product 
licence. 

1 Scope of Licence 

MYOB Technology Pty Ltd (the Publisher), through its local publishers and distribution 
agents, hereby grants to you, the original purchaser, a paid‐up, personal, non‐exclusive and 
non‐transferable Licence to use the Software and the User Documentation only in the 
region, territory or country specified on the packaging, or in New Zealand, subject to the 
terms and conditions of this Agreement. 

a Activation of Company Files You must register the Product and activate the company files 
you create or upgrade with the Software. You are entitled to activate one (1) new or 
upgraded company file. If you are upgrading from a previous version of MYOB Payroll you are 
entitled to activate the same number of files as your previous version. If required, you can 
obtain additional activations by contacting MYOB New Zealand Ltd. 

i) New Company Files You may only access each new company file you create for 90 days 
without registering the Product and activating the company file. After 90 days each new 
company file will become read‐only until you activate it. 

ii) Upgraded Company Files You may only access each company file you upgrade from MYOB 
Payroll 2007 (or earlier) for 45 days without activating the company file. After 45 days each 
upgraded company file will become read‐only until you activate it. Note that for upgrading 
from MYOB Payroll 2007 your company file needs to be confirmed. 
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iii) Licensed employee numbers You are entitled to Create a maximum of 20 employee 
records in your company file. If you have upgraded from MYOB Payroll 2007 (or earlier) or 
have purchased additional employee licences you can create employees based on the 
licence information held by MYOB. 

b Number of Users If you have purchased: 

i) a Single User Software Licence then you may use the Software on only one computer that 
you own or operate at a single physical location in respect of company files you have 
activated. You may transfer the Software from one such computer to another that you own 
or operate provided that you do not use or permit the usage of the Software on more than 
one computer or computer terminal at a time. In the event of an upgrade or Product 
exchange the Licence hereby granted shall automatically transfer to the new version or 
Products. 

ii) a Multi‐User Software Licence then you may use the Software on only one computer 
network that you own or operate at a single physical location and only then in respect of 
company files created and activated by you or by another licensed user. You may transfer the 
Software from one computer to another that you own or operate on this network provided 
that you do not use or permit the usage of the Software on more than the licensed number 
of computers or computer terminals at a time, nor permit the usage of the Software on more 
than one network at any one time, nor permit the Software to be used in respect of company 
files that you have not activated or have not been created by you or by another licensed user. 

c Updates and Upgrades In the event of an upgrade, update or product exchange, the 
Licence hereby granted shall automatically transfer to the new version or product. All rights 
in respect of the original Product shall lapse and no further use of these shall be permitted. 

d Portable or Home Computer and Archive Copies You may make a copy of the Software and 
install it on either a portable computer or a computer located in your home provided that 
the copy is for your own exclusive use and is not operated simultaneously with the original of 
the Software. Otherwise you may not copy or duplicate the Software, except as necessary 
solely for archival purposes, Software error verification, or to replace defective storage 
media, provided you keep the original and the copies. You may not alter, decompile or 
disassemble the Software. You may make copies of the User Documentation up to but not 
exceeding the number of multi‐user Licences you have purchased. 

e Transfers You may not sub‐license, lease, rent or lend the Software or the User 
Documentation or otherwise transfer any of your rights under this Agreement. Subject to 
the prior written consent of the Publisher and the agreement of the transferee to be bound 
by the terms of this Agreement, you may permanently transfer the Software (together with 
any backup copies you have made) and the User Documentation. However, you may not 
retain any copies of either the Software or the User Documentation. 

f Term The Licence granted in this Agreement is effective until terminated. You may 
terminate it at any time by destroying the Software and User Documentation, together with 
all copies, or by returning them to the Publisher. If you fail to meet the ongoing obligations 
accepted by you at the 4 time of registration (if applicable) or if you fail to comply with any 
term or condition of this Agreement, this Licence will terminate and, upon any such 
termination, you agree to destroy the Software and User Documentation, together with all 
copies, or to return them to the Publisher. Termination of this Licence shall be in addition to 
and not in lieu of any other remedies available to the Publisher. 
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g Protection and Security You agree to use your best endeavours and to take all reasonable 
steps to safeguard the Software to ensure that no unauthorised person has access to the 
Product and that there is no unauthorised copying or distribution of the Software or User 
Documentation. 

2 Limited Warranty & Disclaimer 

The Publisher warrants that the media on which the Software is recorded and the User 
Documentation provided with it are free from defects in materials and workmanship under 
normal use for a period of 90 days from the date of your original purchase. Except for the 
limited warranty described above, the Software is sold 'as is', and you are assuming the 
entire risk as to its quality and performance. It is your responsibility to verify the results 
obtained from the use of the Software. 

If during the 90‐day limited warranty period, you discover physical defects in the media on 
which the Software was recorded or in the User Documentation, the Publisher will replace 
them at no charge to you, provided you return the item to be replaced with proof of 
purchase to the Publisher. THIS IS YOUR SOLE REMEDY. IN NO EVENT WILL THE PUBLISHER BE 
LIABLE TO ANY PERSON FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL 
OR SIMILAR DAMAGES, EVEN IF THE PUBLISHER HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. 

Some jurisdictions do not allow the exclusion or limitation of implied warranties or of 
liability for incidental or consequential damages, so the above limitations or exclusions may 
not apply to you. This warranty gives you specific legal rights and you may also have other 
rights that vary from state to state. In the event that any of the above limitations or 
exclusions are held to be unenforceable, the Publisher's total liability shall not exceed the 
amount of the Licence fee you paid. 

3 Entire Agreement 

This Licence constitutes the entire agreement between the Publisher and the Licensee and 
any prior representations, statement or undertaking howsoever made are expressly 
cancelled. No amendment or modification to this Licence shall be valid unless it shall be in 
writing and signed by an authorised representative of the Publisher. 
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1 Your first day 
Learn the basics of MYOB Payroll – how to use windows, icons, and fields, and how to set up 
your payroll file. 

 
 
 

 

Overview of your first day 
 

Your first day with MYOB Payroll will be spent learning about the program, installing it on 
your computer, and setting up your company details so you can start working. 

In addition to this User Guide, you should have received the Getting Started guide. This guide 
should be your first point of reference as it contains the following information: 

 How to register MYOB Payroll 

 System requirements 

 How to install MYOB Payroll 

 How to enter historical payroll information 

 Information about other MYOB resources that could make a difference in your business. 

After you have read Getting Started, you are ready to begin. 

 

YOUR FIRST DAY TOPICS 

 Know what help is available, see ‘Learning Tools’ on page 10 

 Learn how to start your software, ‘Starting MYOB Payroll’ on page 11 

 Experiment without affecting your payroll information, see ‘Explore the sample payroll’ 
on page 12 

 Find your way around MYOB Payroll, see ‘Accessing functions in MYOB Payroll’ on 
page 12 

 Convert your existing payroll system to MYOB Payroll, see ‘Creating a payroll file for an 
existing payroll’ on page 16 

 Get started straight away with a new payroll, see ‘Creating a new payroll’ on page 20 

 Go back in to a payroll file you have created, see ‘Opening an existing payroll file’ on 
page 26. 
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Learning Tools 
 

With MYOB Payroll, you receive a range of learning tools that have been designed to help answer your questions 
about MYOB Payroll and to help you get the most from your software. We encourage you to take the time to 
become familiar with these tools, as they will help you take full advantage of available features and functions. 

When you are using MYOB Payroll, pressing F1 opens the online help to give you immediate assistance and 
information about the window you are in and the task you want to perform. 

 
 

USER GUIDE 

The MYOB Payroll User Guide contains detailed information on how to prepare to use MYOB Payroll, and setup 
instructions to get you up and running with MYOB Payroll as quickly as possible. Illustrations of the MYOB Payroll 
windows, and procedures for all the tasks you can perform, are included in this manual. Keep it handy as you begin 
using MYOB Payroll in your business. 

 
 

ONLINE HELP 

MYOB Payroll comes with a comprehensive help system that you can use as a reference. To access the Online Help, 
choose Contents from the Help menu or press F1 in any window in MYOB Payroll. 

 
 

MYOB TRAINING SERVICES 

MYOB can accommodate all of your training requirements, whether through on‐site training or by attendance at 
one of our regular scheduled training courses. For more information on available training courses and tailored 
training options visit www.myob.co.nz and proceed to the training section or email training@myob.co.nz. 

 
 

KNOWLEDGE BASE 

An online knowledge base is available and includes important information, known issues and common problems. 
To view the online knowledge base, visit the MYOB site at myob.co.nz/supportnotes. 

 
 

MYOB COMMUNITY FORUM 

The MYOB Community Forum is where users of MYOB software and services can ask questions, share information 
and knowledge, and learn from each other. Visit community.myob.com. 
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IRD ASSISTANCE 

Visit the IRDs website at www.ird.govt.nz/payroll‐employers for helpful payroll information. You can also try: 

 www.legislation.govt.nz for NZ Legislation 

 Your local Employers Chamber of Commerce for help on specific personnel issues. 
 
 
 

 

Using MYOB Payroll for the first time 
 

You can experiment with MYOB Payroll to learn about how it works before setting up your own payroll details. The 
following topics are discussed in this chapter. 

 Starting MYOB Payroll, below 

 Explore the sample payroll, page 12 

 Setting up your own payroll; if you have an existing payroll, see page 16 or to create a new payroll, see page 20. 

For information on setting up or maintaining additional payroll details, see ‘Overview of maintenance’ on page 31. 

 

STARTING MYOB PAYROLL 

You can start MYOB Payroll either from the Windows desktop or from the Start menu. 

1    Click the MYOB Payroll icon on the Windows desktop. 
or 

Click the Windows Start button, choose Programs, and double‐click the MYOB Payroll icon in the folder that 
was created when you installed MYOB Payroll. 

If you chose all the default options during the installation process, the MYOB Payroll program was installed in 
the MYOB Payroll program group. 

After a few moments, MYOB Payroll starts and the Welcome to MYOB Payroll window appears. 
 
 
 
 
 
 
 
 
 
 

 
‐ 
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2    Continue with one of these topics: 
 If you have already created a payroll file and want to use it, see ‘Opening an existing payroll file’ on page 26. 
 If you want to get started right away, see ‘Creating a payroll file’ on page 15. 
 To become familiar with your software before setting up your own payroll, see below. 

 
 
 

 

Explore the sample payroll 
 

A great way to learn how to use MYOB Payroll is to see and play with actual data that has been entered into the 
MYOB Payroll system. By doing so, you can learn how your data should be entered. 

We have created a sample company, Clearwater Ltd, for this specific purpose. Using Clearwater’s payroll file, you 
can experiment freely with features without affecting your company’s information. We recommend you spend 
some time with Clearwater’s data to familiarise yourself with the way your software works. 

 
TO EXPLORE THE CLEARWATER PAYROLL FILE 

1 Click Explore the sample Payroll in the Welcome to MYOB Payroll window. 
 

 

The MYOB Payroll command centre window appears. This window always appears when MYOB Payroll is 
running. Notice that the name of the sample company, Clearwater Ltd, appears in the top left of the window. 

2 Now that Clearwater is open, feel free to browse MYOB Payroll and explore the sample company. 

For information on getting around, see ‘Accessing functions in MYOB Payroll’ below. 

 
 

 

Accessing functions in MYOB Payroll 
 

You can access MYOB Payroll functions using one of the following navigation methods. 

 Command centres, page 13 

 Menus, page 13 

 Hot keys, page 14 

 Types of fields and buttons in MYOB Payroll, page 14 

 Learning Tools, page 10. 
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COMMAND CENTRES 

Command centres enable you to quickly and easily access the required functions of MYOB Payroll using icons, 
similar to the way you may use tool bars in other Windows systems. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

. 

There are three command centres, which are based on the major functions that you will perform in MYOB Payroll. 
They are: 

 Maintenance command centre, used to record and edit employee, pay code and department information. 

 Prepare Pays command centre, used to add timesheets, enter current pay run information and print pay slips. 

 Process Pays command centre, used to finalise your pay run, create necessary ir‐Filing and direct credit files 
and update the PAYE period. 

The command centres contain a row of icons in the top half of the window, which represent the three areas of 
MYOB Payroll. Each time you view the central location for all command centres, one of the icons is highlighted, 
and a flowchart of tasks is displayed below the row of icons. 

The highlighted icon is the current command centre, and the flowchart displayed below the row of icons contains 
the major functions associated with that command centre. For example, when the Prepare Pays function is 
highlighted, functions such as Enter Timesheets and Calculate Default Pays – typical tasks you’d complete with 
preparing pays are displayed in the flowchart. 

To display a command centre, click once on the icon of the command centre you want to see. 

Tasks are accessed from command centres simply by clicking once on the function icon. When you select a 
function, a window will appear where you can make the necessary entries to perform the function. 

 
MENUS 

The menu allows you to access all functions from one location, including some that are not available from 
command centres, such as Options. 

The menus are ordered in a hierarchical structure. Use the standard Windows method to access a function from a 
menu. The arrow next to a menu item indicate that there are additional sub‐menus for this item. 
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HOT KEYS 

You can access some functions using shortcut keys. These keys are listed below: 

F1 Online Help 

F6 Insert current date 

F8 Delete record 

Ctrl+O Open a payroll 

Ctrl+P Print 

TYPES OF FIELDS AND BUTTONS IN MYOB PAYROLL 

You will find the following types of fields and buttons used in MYOB Payroll. 

Data entry      Data entry fields allow you to enter information in your 
payroll file. 

Radio 
buttons 

          Radio buttons allow you to make a selection from a 
number of choices. Radio buttons are selected by 
clicking the circle next to the text that accompanies it. 

Tabs          Tabs allow you to switch between views in a window, 
such as Personal Details in the Maintain Employees 
window. To select a new view, simply click the tab 
required. 
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Ellipsis 
button 

Click the ellipsis button [...] to access a related tool, 
such as a calculator, or to open a window with more 
information about the item. 

Ctrl+D Print Direct Debit fax (for sending to the bank) 

Button Buttons come in a few different styles in MYOB Payroll. 
Generally, the purpose of buttons is to perform an 
action or step, such as opening a window. 

Checkboxes Checkboxes allow you to activate or deactivate a 
particular MYOB Payroll function. Checkboxes are 
selected by clicking the square next to the text. 

Function key Action 

F4 Add record 

F7 Delete after cursor 

F9 Lookup 

Ctrl+N Create a new payroll 

Field type Example Description 



 

LIST WINDOWS 

In addition to field and buttons, you’ll find List windows. These let you enter data by clicking an item presented in 
a scrolling list. For example, if you are setting up pay defaults for an employee, you can press F4 to add a new pay 
code, as shown in the following illustration. 

 

 

List windows differ depending upon the window in which they appear. 
 
 
 

 

Creating a payroll file 
 

There are two ways you can create a payroll file. You can: 

 convert your existing payroll system to MYOB Payroll, see ‘Creating a payroll file for an existing payroll’ below 

 set up a new payroll with no prior payroll information, see ‘Creating a new payroll’ on page 20. 

Below is a list of information that is generally required to set up your payroll. 

 Employee list 
 Pay codes (the components that make up an employee’s pay, such as ordinary time, overtime, leave, tax, and 

so on) 

 Departments 

 Cost centres 

 Leave details 

 Leave anniversaries 

 PAYE settings 

 Direct credit files 

 System preferences 
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CREATING A PAYROLL FILE FOR AN EXISTING PAYROLL 

MYOB Payroll allows you to enter historical information from your previous payroll system, bringing you 
up‐to‐date and ready to process your next pay run. 

 
Entering historical information is optional Pay history is used for the calculation of annual leave rates. If you 
don’t enter historical information, you will need to manually override the gross earnings for the last 12 months 
each time an employee takes leave. Note that if you need a full record of historical information, you will need to 
re‐enter pays using the pay‐by‐pay method. This involves processing each pay run separately from the start of the 
tax year. 

 
Annual Leave anniversary   Before you start using MYOB Payroll decide if you will use a common anniversary 
(used when a firm has a compulsory closedown period such as two weeks over Christmas) or individual 
anniversaries (based on the employee’s start date). 

 
TO CREATE A PAYROLL FILE FOR AN EXISTING PAYROLL 

1 Start MYOB Payroll and click Create a new Payroll from the welcome window that appears. 

The New Payroll window appears. 
 

 
 

2 Enter the name of the payroll. 

3 Check that the tax year end date is correct and set the current month to the month prior to the first month you 
are planning on entering pay history for (for example, 12 months ago; you may need to also change Tax Year 
End to the relevant year) or processing live pays. 

4 Click OK. The Payroll Options window appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 6 C H A P T E R   1 Y O U R   F I R S T   D A Y 



 

5 Enter your payroll settings. If you are using a common anniversary set this under the Leave tab. Note that this 
information can be changed after the payroll has been created (go to the Tools menu and choose Options). 

 

 

6 Click OK. The Payroll Command Centre now appears. 

7 [Optional] Set up Departments/Cost Centre. Some businesses use separate departments to track wages 
expenses and other employee information. 
a Go to the Maintenance command centre and click Maintain Departments. 
b Click New in the window that appears. The New Department/Cost Centre window appears. 
c Enter the details of your department and then click OK. 
d Repeat from step a above for each department. 
e Click Close. 

 
                                                  

    

NOTE :  General Ledger codes    A message will appear to let you know that general ledger codes haven’t been assigned to your 
departments. Return to this window and enter the General Ledger codes after setting up your accounting integration. For 
information about integrating with your accounting software, see ‘Integrating with other MYOB software’ on page 27. 
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8 Set up Employees. 
a Go to the Maintenance command centre and click Maintain Employees. 
b Click New. The New Employee window appears. 

 

 

c Enter a code in the Employee Code field. Each employee must have a unique code (which can be numbers 
or letters). We recommend the first four or five letters of the surname followed by the initials. This ensures 
that reports will be printed in alphabetical order for surnames. Numeric codes can be used; however, you 
must include leading zeros to ensure the sort order is correct (for example, 001, 002, and so on). 
The Copy the following information option is useful when adding employees who share similar information, 
and saves you from having to re‐enter information. Click in the field and press F9. In the list that appears, 
select the employee you want to copy details from and click OK. Once the employee is added, you can 
customise employee details (such as assigning them a department and adding a start date). 

d Click OK. The first step of the New Employee Setup Wizard appears. 
e Enter the basic pay details such as start date, IRD number and tax code. 
f Click Next and enter the days per week and hours per day normally worked. Your normal hours per week is 

calculated. Normal hours per week is used to calculate employee leave allocation. For example, if your 
normal hours per week is 40, your employees will be allocated 4 weeks of 40 hours of annual leave per year 
(160 hours). 

g Click Next and enter the KiwiSaver details for the employee. 
h Click Next and then Finish. 
i Repeat from step a above for each employee. 
j Click Close. 

9 If you want to enter pay history, you can enter it now by processing the historical pay runs (refer to the F1 help 
or User Guide for more information on entering pays). When prompted to update an employee’s leave details, 
make sure you do so. If you prefer to keep details of the historical and current pays separate, use the YTD... pay 
codes. 

10 Enter Leave details. Before you enter these details, you will need leave information from your previous payroll 
system. 
a Go to the Maintenance command centre and click Maintain Employees. 
b Click the Leave Details tab and then click Annual Leave & Holiday Pay. 
c If you haven’t already done so, enter the normal days per week and normal hours per day worked. Your 

normal hours per week is calculated. Normal hours per week is used as the basis to calculate employee leave 
allocation. For example, if your normal hours per week is 40, your employees will be allocated 4 weeks of 40 
hours of annual leave per year (160 hours). 
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d Enter an anniversary date. This date is used to calculate leave. By default, the anniversary date is based on 
the employee start date, for example, 12 months after start date. If you are converting from another payroll 
system, you will need to enter the anniversary date to ensure leave is correctly calculated. 

e Enter the gross earnings since the employees start date (or the employees last anniversary date) and the 
holiday pay percentage. The holiday pay percentage is usually 8% (that is, four weeks annual leave). The 
opening Holiday Pay Due balance needs to be manually entered. In most cases, it is 8% of the gross earnings 
figure. When you start processing payroll, this figure is automatically update after each pay is finalised. 

f Enter any annual leave due when you started using MYOB Payroll in the Annual Leave due as at field (this 
may be negative for employees who have taken leave in advance). The Current Annual Leave due should 
now show the employees correct amount of leave due. If it doesn’t, modify the hours in the Annual Leave 
due as at field to correct (negative amounts can be used). 

 

 

g In the Other Leave tab, enter: 
 sick leave days currently owing in the Current Sick Leave field. Also enter the maximum number of days that can be 

accrued, and the number of days that should accrue each year. 
 alternative holidays currently owing in the Current Alternative Holidays Due field. 

You are now ready to start using MYOB Payroll to process pay runs. 
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CREATING A NEW PAYROLL 

You can start using MYOB Payroll immediately, with no prior payroll information. 
 

TO CREATE A NEW PAYROLL 

1 Start MYOB Payroll and click Create a new Payroll from the welcome window that appears. 

The New Payroll window appears. 
 

 
 

2 Enter the name of the payroll. 

3 In New Zealand, the tax year end always ends on 31st March. 

4 Set the current month to the month you want to process live pays. This ensures the Employer Monthly 
Schedule (EMS) is correct. 

5 Click OK. The Payroll Options window appears. 

6 Enter your payroll settings. If you are using a common anniversary set this under the Leave tab. Note that this 
information can be changed after the payroll has been created (go to the Tools menu and choose Options). For 
more information, see ‘Payroll options’ below. 

 

 
 

7 Click OK. The Payroll Command Centre now appears. 

You are now ready to finish setting up your new payroll and start processing live pays. 

 To finish entering payroll information in the Payroll Options window, see page 21. 

 To complete any setting up of employees, pay codes or departments, see page 31. 

 Start processing live pays, see Chapter 3, Preparing pays, on page 73. 
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Payroll options 
 

You can change options after the payroll is created. Choose Options from the Tools menu at the top of the 
command centre. 

 
 

CONTACT DETAILS 

The Contact tab allows you to enter contact details for your business. 
 

 
Note the following: 

 The name entered in the Trade Name field appears as the company name on pay slips and other printed 
reports. 

 The contact name and the phone number are included in the EMS and the Employee’s certificate of earnings. 

 KiwiSaver requests employers to provide a mobile phone number. 
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GENERAL DETAILS 

The General tab allows you to specify information about PAYE, MyStaffInfo and KiwiSaver. 
 

 
 

IRD 

Your IRD (Inland Revenue Department) number is the number that identifies your company to the IRD. You need 
to enter your IRD Number to ir‐File employee information, which appears on the Employer Monthly Schedule 
(EMS). 

PAYE is paid to the IRD either half‐monthly or monthly. If your total annual PAYE payments are in excess of 
$500,000, then you are considered a large employer, and are required to pay PAYE half‐monthly (on the 5th and 
20th of the month). Otherwise payments are due monthly on the 20th. 

 
CASH DENOMINATIONS 

These settings are used when employees are paid in cash. Maximum denominations for cash payments relates to 
the largest notes used for cash wages. The minimum applies to the payment level that you want rounded. For 
instance, if the pay is rounded to the nearest dollar choose 1.00 for the minimum denomination. 

 
SALARY CALCULATIONS 

The Hours per Year and Standard Hours per Day settings dictate how the pay rate is calculated when an annual 
salary is entered in the employees' employment details. 

Enter the default standard hours for employees in the Standard Hours per Day field. The Hours per Year options 
will update accordingly. Individual employee settings can be maintained in the Employee Maintenance section, 
see ‘Employment Details tab’ on page 48. 

For example, if you enter eight hours the available options are: 

 2080 = 260 days (52 weeks x 5 days) x 8 hours ‐ default 

 2088 = 261 days (365 days in the year ‐ 104 weekend days) x 8 hours 

 2085.71429 = 260.71429 days (365 days in the year / 7 days per week x 5 working days) x 8 hours. 
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LEAVE DETAILS 

LEAVE ANNIVERSARY 

Before you start using MYOB Payroll, you need to decide if you will use a common anniversary or individual 
anniversaries (based on the employee’s start date). Most businesses use individual anniversaries. 

If you want to use a common anniversary, select the option and enter the date of the next anniversary. When 
using a common anniversary, you can also specify that any permanent employees (who have been employed since 
the last common anniversary date) will have their balance of holiday pay converted to annual leave when the next 
anniversary date occurs. If this option is not selected, the holiday pay balance will be carried forward into the next 
period and no allocation of annual leave is made. 

 
PAY SLIPS 

Use the Pay Slips options to specify how you want accrued leave printed on your employees’ pay slips. For more 
information about annual leave and holiday pay for individual employees, see page 61. If you want, you can 
specify that emailed payslips are password‐protected with the employee’s IRD number. 

 

 
 
 

ACCOUNTING INTEGRATION DETAILS 

The Accounting tab allows you to specify information for exporting payroll information to your MYOB 
AccountRight or other accounting software. 

 
ACCOUNTING SYSTEM 

When you set up accounting integration, you can create journals to import into your accounting software. This 
keeps your accounts up‐to‐date and provides you with cost analysis information for each department. 

You can integrate with MYOB AccountRight software, or with other accounting packages. 

If you are integrating with MYOB AccountRight, you can post your GL journals: 

 Manually, using the Create Journals option from the Tools menu. See ‘Creating accounting journals’ on 
page 104 for more information. 

 Automatically, by selecting the Automatically post journals into the company file option in this window. 
Journals will be automatically posted to the specified company file and product specified after each pay run. 

For information on how to integrate with MYOB software, see Integrating with other MYOB software, page 27. 
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BANK & IRD 

You can use MYOB Payroll to create files for electronically filing information with the IRD. Employers who file 
electronically do not need to fill out a paper Employer Monthly Schedule. 

The Bank & IRD tab is used to record direct credit bank account information and the location to which you want to 
save your Employer Monthly Schedule (EMS) file. 

 
DIRECT CREDIT PATH 

If you want send direct credit files to your bank enter the bank account from which payments will be made. Select 
a directory where the direct credit file will be saved to, clicking on the ellipsis button to browse. A file name will 
automatically be added of the correct file type (extension) based on the bank account details entered. When you 
finalise the pay, the direct credit file is saved to the specified folder. 

Please consult the F1 online help for any detailed information relating to specific bank account formats or file 
extensions. 

Alternatively, some banks allow you to send batches to them on a disk. 
 

 
 

IR-FILE 

The location on your computer where you want to save your Employer Monthly Schedule (EMS), also known as 
the IR348, each month when you create it. 

 
 

REMINDERS 

MYOB Payroll allows you to create reminders to alert you on a future date. Press F4 to add a new Reminder and 
when the pay date is equal to or greater than the date entered, an alert will remind you to take the noted action. 
Press F8 to delete an existing reminder. 
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SYSTEM DETAILS 

Prompts can be switched off by deselecting the relevant option. 

By selecting the Prompt for printer when printing reports option, you can select which printer you want to use 
when printing. If not selected, reports are sent to your default printer. 

 

 

If your payroll is stored on a server or another computer, you can change the location where MYOB Payroll looks 
for the payroll data files. Click the ellipsis and browse for a different location. However, note that if you change this 
location, you will need to move your data folder to a mapped network drive and then direct MYOB Payroll to this 
location. 

If you want MYOB Payroll to automatically confirm your payroll data file when required, select this option. 
 
 

SAVING YOUR SETTINGS 

When you have finished entering your payroll options, click OK to save your settings. When you click OK, the 
command centre appears. 
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Opening an existing payroll file 
 

TO OPEN AN EXISTING PAYROLL FILE 

1 If you have created a payroll file it can be opened by clicking Open your payroll from the Welcome to MYOB 
Payroll window. 

If you have another payroll file open, go to the File menu and choose Open. 

The Open a Payroll window appears. 
 

 

2 Select your payroll file from the Select Payroll list. Once selected, basic information about the payroll appears. 

3 Enter a password, if required. 

4 Click Open. 

Note that, from this window, you can also delete the payroll file. Click Delete to permanently delete the currently 
selected payroll. If required, you must first enter the payroll’s password before you can delete it. 

 
 
 

 

Exiting MYOB Payroll 
 

To close MYOB Payroll, go to the File menu and choose Exit. You can also click the ‘x’ in the top right corner of the 
main window. 

If the Exit Confirmation option is selected, click Yes to the message that appears. To switch this option off, see 
page 25. 
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Your MYOB Payroll data file 
 

When you make entries in MYOB Payroll, that information is stored in a file in your computer called a payroll data 
file. This file allows you to work with your company’s financial information without spending a lot of time and 
effort with your computer’s file storage system. 

You can use MYOB Payroll to keep payroll records for more than one company. If you do so, one payroll file will 
exist for each company. A payroll file is created immediately when you create a new payroll. 

 
LOOKING AFTER YOUR PAYROLL DATA FILE 

It is very important that you take steps to make sure your data is protected from the following hazards: 

 viruses 

 file corruption 

 hardware failure 

 unauthorised use 

 operator error. 

For information on how you can protect your data, see the following topics: 

 ‘Backing up and restoring your data’ on page 106 

 ‘Repairing the payroll file’ on page 108 

 ‘Managing passwords’ on page 108. 
 
 
 

 

Integrating with other MYOB software 
 

You can export payroll journals from MYOB Payroll and import them into MYOB accounting software, such as 
MYOB AccountRight. 

 
Task 1: Set up payroll accounts in AccountRight 

If you’re using AccountRight, you need to set up both debit and credit accounts to account for your payroll 
expenses. Add to your AccountRight accounts list: 

 Credit accounts—Payroll Suspense or Payroll Liability account. If you want, you can add individual accounts for 
tax, deduction and payment accounts. 

 Debit accounts—Add wages expense accounts for individual departments, as required. 
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Task 2: Select your company file 

1 In MYOB Payroll, go to the Tools menu and choose Options. The Payroll Options window appears. 

2 Click the Accounting tab. 

3 If you use AccountRight, follow the instructions for the version you are using and where your file is stored. 
 

                                                    
   

NOTE :  Integrating with an AccountRight 2013 file on the desktop?    You first need to install the MYOB API. Read this support 
note for instructions on how to do this. For AccountRight 2014 or later, the MYOB API is called the MYOB Add‐On Connector and is 
installed automatically when you install AccountRight. Note that the API doesn’t work on Windows XP or Vista. 

 
                                                    

   

 

 
v19 Desktop 1    Select the MYOB AccountRight v19 option. 

2 Click the [...] button and select your company file. 
3 Enter the username and password for the file. 

2013 or later 
 

(not compatible 
with Windows 
XP or Vista) 

 
 
 

2013 or later 
 

(not compatible 
with Windows 
XP or Vista) 

 
2013 or later 

 
(not compatible 
with Windows 
XP or Vista) 

Online 1    Select AccountRight 2013 and later and click the [...] button. 
2 In the Library Browser window that appears, select Online and click 

Connect. 
3 Enter your AccountRight Live sign‐in details (these are the same as your 

my.MYOB account details). 
4 Select the file you want to connect to and click OK. 
5 Enter the username and password for the file and click OK. 

Desktop 1    Select AccountRight 2013 and later and click the [...] button. 
2 In the Library Browser window that appears, select My Library and click 

Connect. 
3 Select the file you want to connect to and click OK. 
4 Enter the username and password for the file and click OK. 

Network 1    Select AccountRight 2013 and later and click the [...] button. 
2 In the Library Browser window that appears, select Network Library. 
3 Enter the computer’s name (or network address) and the port number to 

use (if the default number can’t be used) and click Connect. 
4 Select the file you want to connect to and click OK. 
5 Enter the username and password for the file and click OK. 

 

4    If you use MYOB Accountants Office or MYOB Cashbook: 
a Select the Other option. 
b Type the data folder path in the Path field. For example, C:\Program Files\MYOB\Cashbook\Data\Clnt1. 
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AccountRight File location Do this: 

http://myobnz.custhelp.com/app/answers/detail/a_id/30682
http://myobnz.custhelp.com/app/answers/detail/a_id/30682


 

Task 3: Set up posting options 

1 In the Payroll Options > Accounting tab, select the default payroll liability account to which you want to post 
your payroll journals. 

If MYOB Payroll locates a valid chart of accounts, a drop‐down list will be available. Select an account, for 
example, Wages Liability, from the chart of accounts displayed in the drop‐down list for the default payroll 
liabilities account. 

 
                                                  

     

NOTE :  Tax, deduction or payment accounts set up in the Maintain Pay Codes window will override the default liability account 
set up in the Options window    If you have setup specific liability accounts for taxes, deductions or payments, specify these in 
Maintain Pay Codes, these will override the default liability code set here. 

 
                                                  

     

 
2 If you want the journals to have individual lines for each employee, select the Create separate journals for 

each employee option. 

3 If you want to use your MYOB Payroll cost centres as job codes in the AccountRight journals, select the Include 
cost centres as job codes in journals option. 

4 To automatically post journals to the company file (recommended), select the Automatically post journals 
into the company file option. 

5 Click OK. 

6 If you want to select account codes for each department or cost centre, go to the Maintenance command 
centre and click Maintain Departments. 

7 If you want to select account codes for your pay codes, click Maintain Pay Codes in the Maintenance 
command centre. You can select a General Ledger code in the Other tab for each Deduction, Tax or Payment 
code. 

 
Task 4: Export payroll journals 

When a pay is finalised, MYOB Payroll automatically creates a journal file, formatted for the relevant integration 
settings. 

The journals contain debit entries for the gross wages costs allocated to each department for the pay (gross 
earnings, taxable allowances and non‐taxable allowances) and a credit entry for the total wages cost for that pay. 

You can export the journals manually or automatically. See ‘Creating accounting journals’ on page 104 for more 
information. 
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2 Maintenance 
Set up and maintain the payroll file, including employees, departments, leave details, cost centres, deductions and 
pay codes. 

 
 
 

 

Overview of maintenance 
 

When you set up your payroll, you entered the information you had on hand the time. As your business changes, 
you’ll need to add or change existing details. For example, you may need to add new employees or update leave 
details. In MYOB Payroll, these tasks are called maintenance. You’ll use the Maintenance command centre do 
most of these tasks. 

 

 
 

TO GO TO THE MAINTENANCE COMMAND CENTRE 

1 From any MYOB Payroll command centre, click the Maintenance icon. 

2 The Maintenance command centre appears. You can do the following tasks: 
 

 
Add, edit, or delete departments or 
costcentres 

‘Maintaining departments and costcentres’ 
on page 32 

 

 
Add or maintain employee details ‘Maintaining employees’ on page 45 

 

 
Using Accumulators in MYOB Payroll ‘Maintaining Accumulators’ on page 70 
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Managing employee leave details ‘Processing employee leave’ on page 61 

Add, edit, or delete pay codes ‘Maintaining pay codes’ on page 34 

To do this … Continue with … 



 

 
 

Maintaining departments and costcentres 
 

The departments and costcentres feature allows you to analyse your payroll costs in more detail. To access this 
feature, go to the Maintenance command centre and click Maintain Departments. 

 

 

A default department is set up when you create a new payroll. The details of this department can be changed or 
deleted, however, there must be at least one department. 

If you are integrating with MYOB AccountRight, you can enter a general ledger account code (see ‘Accounting 
integration details’ on page 23) to automatically post accumulated costs. 

Employees must be assigned to a department. If you don’t assign a department to an employee in the employee’s 
setup, or split between departments when entering pay details, the employee's pay will be automatically 
allocated to the default department. 

If you don’t want to delete a department, you can hide it. Select the This Department/Costcentre is no longer 
used option and then select the Hide Department/Costcentres no longer used option. Note this option is only 
available if it has not been assigned to an employee. 

 
COSTCENTRES 

To help you understand how costcentres are used in MYOB Payroll, keep in mind the following: 

 Costcentres cannot exist on their own; they must be part of a department 

 Costcentres are added when adding or editing a department 

 Costcentres are deleted when all departments that use that costcentre have been deleted 

 The same department can be added several times if the costcentre details are different or multiple 
departments can use the same costcentre details. 
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TO ADD A NEW DEPARTMENT 

1 Go to the Maintenance command centre and click Maintain Departments. 

2 Click New. The New Department/Costcentre window appears. 
 

 

3 Enter a code and description for the department. The codes are alphanumeric (combination of numbers and 
letters) and can be up to eight characters long. The description can be up to 25 characters long. 

4 If you want to add costcentre details, enter them now. 

5 Click OK. The department code is added to the list and the details appear in the General tab. 

6 If you are integrating with MYOB AccountRight, enter a general ledger account code (see ‘Accounting 
integration details’ on page 23) to automatically post accumulated costs. Note that you need to enter an 
account for tracking expenses. 

 
TO DELETE A DEPARTMENT 

1 Go to the Maintenance command centre and click Maintain Departments. 

2 Select the department you want to delete and click Delete. Departments cannot be deleted if they are still in 
use by an employee, so it’s advisable to delete any departments at the end of the financial year. 

 
TO CHANGE A DEPARTMENTS DETAILS 

1 Go to the Maintenance command centre and click Maintain Departments. 

2 Select the department you want to change. 

3 Enter the required changes in the General tab. 
 

LINKING TO MYOB GENERAL LEDGER OR CASHBOOK SOFTWARE 

If you are integrating MYOB Payroll with MYOB AccountRight software (see ‘Accounting integration details’ on 
page 23), you will need to select a matching expense account code for each department. The list of available 
expense codes appears in the General Ledger Code list. This list shows the chart of accounts of the company file 
you are integrating with. 

Note that as you are tracking department expenses, you need to select an expense account such as wages & 
salaries. 

 

 
 
 
 

M A I  N T A I N I N G   D E P A R T M E N T S   A N D   C O S T C E N T R E S 3 3  



 

 
 

Maintaining pay codes 
 

Pay codes are used to enter pay details for employees and to define the individual components that make up an 
employee’s pay. 

Some tax codes are provided by default. These are known as standard pay codes. You can add or modify the details 
of these pay codes, however, they cannot be deleted. 

If a pay code is no longer active, it can be marked as no longer used. Alternatively, you can set the pay code type to 
OLD, see Pay Defaults / Totals tab, page 50. 

It is recommended that you setup pay codes before adding any employees. 

In the Maintenance command centre, click Maintain Pay Codes. 
 

 
 

TO ADD A NEW PAY CODE 

1 Go to the Maintenance command centre and click Maintain Pay Codes. 

2 Click New. The New Pay Code window appears. 
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3 Select a pay code type from the Pay Code Type list (see ‘Pay code types’ below). Note that once you create the 
pay code, you cannot change the pay code type. 

4 In the Pay Code field, enter a short description, with no spaces, up to eight characters long. This will be used 
when entering pay details for an employee. 

5 In the Pay Code Description field, enter a more complete description of what the pay code is for. This will 
appear on the employee’s pay slip. 

6 If you want all existing employees to have this new pay code, select the Add this Pay Code to all current 
employees option. This option is unavailable if you have an active pay. 

7 Click OK. The new pay code appears in the pay code list and the pay code details appear in the panel on the 
right. 

8 Enter the pay code details. See ‘Editing pay codes’, on page 36. 
 
 

PAY CODE TYPES 

You can choose from seven pay code types when creating a pay code. 
 

 
Gross earnings Taxable earnings on which holiday pay is calculated. All earnings that 

the employer is required to pay by the employee’s terms of the 
employment, attract holiday pay. Most employee earnings are in 
this category, which includes annual leave, all allowances and 
performance related earnings. For example, shift allowances, 
commissions and bonuses. The cash value of board or lodging 
provided by the employer is also defined as gross earnings. 

 

 
Pre‐tax 
deductions 

Deductions from pay before tax is calculated. 

 

 
Non‐taxable 
allowances 

Reimbursing allowances that are not taxable, such as meal and 
mileage allowances. 

 

 
Payments Net pay paid out as cash, cheque or direct credit. 
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Post‐tax 
deductions 

All deductions from pay after tax has been calculated. Payments 
made on behalf of the employee such as union dues, social club and 
superannuation contributions. 

Taxes PAYE deductions. 

Taxable 
allowances 

Taxable earnings on which holiday pay is not calculated, such as 
one‐off bonuses, or any other lump sum special payment that the 
employer is not required to pay by the employee’s terms of 
payment. This includes redundancy pay and the payment of holiday 
pay itself. 

Pay Code type Description 



 

 
 

Editing pay codes 
 

You can change the details of a pay code, except for the pay code type. You enter these changes in the Edit Pay 
Codes window. 

 
TO EDIT A PAY CODE 

1 Go to the Maintenance command centre and click Maintain Pay Codes. 

2 Select the required pay code from the list. When you select a code, the pay code details appear in the right 
panel of the window. You can edit it using the five available tabs. 

 

 
General Edit the description and name of the pay code, and other general 

pay code information. 
page 37 

 

 
Other Set up direct credit bank account details, department and 

costcentre analysis, and enter pay code default quantities. If you 
integrate your accounting software, you can enter a liability 
account code for tax, payment and deduction codes. 

page 40 

 

 
Totals View monthly totals for this pay code for the current year. page 44 

 
 

 
                                                      

    

NOTE :  Unavailable fields    Some pay code details cannot be changed, such as the pay code type and the set up of default pay codes. 
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Accumulators Define accumulators associated with a pay code. page 43 

Employer Super Define superannuation contributions associated with a pay code. page 39 
Only available for Pre‐tax deduction or Post‐tax deduction pay 
codes types. 

Tab Description See 



 

C Pay Code rate is 
based on 
employee’s pay 
rate 

Each employee can have up to three basic rates of pay. These are set in the employee’s 
Employment Details tab. 

GENERAL TAB 

This tab allows you to specify basic pay code information. 

 

 
 

 
B Units If you are creating a Gross Earnings pay code type, you can define a single unit of 

activity. For example, ordinary time could be hours, picking apples could be bins. 
 
 
 
 
 

 
D 

 
Multiplied by 

 
If the pay rate for the pay code you are adding is a multiple of one of the basic rates, 

 select Normal, Second or Third and enter the multiplier (or rate factor) in the 
Multiplied by field. For example, time‐and‐a‐half has a rate factor of 1.5. Remember, if 
you base the pay code on a rate and multiply it by zero, it will always calculate zero 
regardless of the quantity. 
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A Pay Code, Type & You can change the pay code description, with the exception of some default codes and 
Description the pay code type. This is set when the pay code is created. 

 
 
 

A 
 

  B 
 

C 
 

   D 

E 
 
 

  F 



 

 

E Default Pay Rate If you do not want to use the employee’s pay rate, choose a rate of None and enter a 
rate in the Default Pay Rate field. 
If you want this rate to apply to all employees assigned this code, select the This rate is 
common to all employees option. With this option selected, employees are 
automatically updated if you change the rate. However, any active pays will use the old 
rate unless the pay is cleared and re‐entered. 

F Pay code options If you want to change the pay rate when entering an employee’s pay details, select the 
 Allow rate to be modified when entering pay details option. This is recommended 

where the pay code rate varies with each pay, such as a bonus pay code. If the new rate 
will include holiday pay, select The modified rate is inclusive of Holiday Pay option. 
When this new rate is entered to overwrite the current rate, it will automatically be 
reduced so that the holiday pay portion is split out. This is not a common situation. 
You can print pay rates as percentages on pay slips by selecting the Print on pay slips as 
a percentage option. If a rate is a percentage of gross earnings, (for example 
superannuation deductions) select this option to automatically print the rate as a 
percentage on pay slips (for example, a rate of 0.05 will print as 5%). 
If the pay code is to be added to the default pay details of new employees, select the 
Use this Pay Code for all new Employees option (see ‘Pay Defaults / Totals tab’ on 
page 50). 
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SUPER TAB 

This tab is only available for pre‐tax deductions or post‐tax deduction pay codes. 
 
 
 
 

A 
 

B 

C 

D 

E 

F 

G 

 
 

H 

 
 

 
B Superannuation 

Fund Name 
Enter the fund name as it will appear on pay slips. 

 

 
D % of Employee 

Contribution 
This field determines the employers contribution as a percentage of the employee’s 
contribution. For example, if the employer is paying the same amount as the employee, enter 
100%. 

 

 
F Maximum 

Amount 
This field can be used as a limit on the calculations in the other fields or as a fixed dollar 
amount. 

 

 
H Dept/Cost Centre  If employer super contributions are to be assigned to a specific department or cost centre for 

accounting purposes, select it here. 
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G Include with 
Direct Credits 

Select this option to include superannuation payments with the payroll direct credit files. 
Complete the relevant bank account details on the Other tab, page 40. 

E Maximum % of This field calculates the employer’s contribution as a percentage of the employee’s gross 
Employee’s Gross earnings. For example, an employer matches the employee’s contribution but will not pay 
Earnings more than 5% of the employee’s gross earnings. An employee can contribute any percentage 

of their earnings they like and the employer will match this up to the maximum set here. 

C Contribution 
Formula 

This is only used for reporting purposes and is not used to calculate the actual contribution. 

A Activate super 
contributions 

If you want to use this pay code for Superannuation deductions, select the Employer 
Superannuation Contributions are based on this pay code option. You can then define how 
the superannuation contributions are calculated. 

   
 
   
   

   
 
   

   
 

   

   



 

OTHER TAB 

The Other tab includes details about cost analysis and direct crediting of payments. 

 

 
 

 
B Include in Direct 

Credit Schedule 
Select this option to include the pay code on the Direct Credit Schedule. If you want the 
direct credit amount to print separately, select the As separate amounts for each 
employee option. 
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C Nominated bank Enter the bank account this payment will be credited to (you first need to select the 
account Include in Direct Credit Schedule option). You can use this to organise superannuation 

credits or to set up payment of an employee’s wages to a credit card account (for details 
of the correct bank account and reference details required, contact the card issuer). 
Each employee has one default bank account set up in employee maintenance. If you 
want to split an employee's wages between multiple bank accounts, you need to set up 
a new payment type pay code for each additional bank account that the employee 
requires. See ‘To set up multiple bank accounts for an employee’ on page 41. 

A Department and This field can be used to export payroll costs by department. 
cost centre Wage costs can be calculated for accrual accounting purposes when posting to MYOB 
analysis AccountRight software and when printing the cost analysis and period reports. For 

example, accruing leave, based on actual wages paid. 
For gross earning and allowance pay code types, you can assign a department. This will 
override the employee’s default department (however, defaults can be overridden when  
entering pay details by clicking the Split Pay button). 
For tax, deduction and payment pay code types, you can assign a liability account code. 
If no accounts are specified, payroll journals will use the default payroll liability account 
set in your payroll options, ‘Accounting integration details’ on page 23. 

  A 

  B 
 

C 

D 

E 



 

D Use the Total 
Gross Earnings for 
the Employee's 
pay as the default 
Quantity for this 
Pay Code 

Select this option for any pay code that will use the total amount of earnings as its base 
pay rate. For example, if an employee wants to contribute 5% of gross earnings to a 
super fund, set up the superannuation pay code and select this option. In the 
employee’s Pay Defaults/Totals tab, enter 0.05 in the Rate column. 

 

E Payroll giving If this deduction is eligible for the payroll giving scheme, select the This deduction 
 qualifies for the Payroll Giving Tax Credit option. Note that is option is not active if you 

have set up the pay code to calculate superannuation or you have not entered a file path 
in the ir‐Files field (Payroll options window). For more information, see ‘Payroll giving’ 
below. 

 

TO SET UP MULTIPLE BANK ACCOUNTS FOR AN EMPLOYEE 

1 Go to the Maintenance command centre and click Maintain Pay Codes. 

2 Click New. The New Pay Code window appears. 

3 Select the Payments Pay Code type. 

4 Enter a pay code description. We recommend that you use the prefix 'DC' followed by the employee's initials 
in the code to make it unique. 

5 Click OK. The new pay code appears in the pay code list and the pay code details appear in the panel on the 
right. 

6 Click the General tab. 

7 In the Default Pay Rate field, enter the amount the employee wants to credit to that account. 

8 Select the Allow Rate to be Modified option. This allows you to change the default rate when entering the pay 
details. 

9 Click the Other tab and enter the bank account details. 

10 Add the pay code in the employee’s pay details (you do this from Pay Defaults/Totals list in the Maintain 
Employees window). 

For information on setting up an employee’s default bank account, see ‘Employment Details tab’ on page 48. 
 

PAYROLL GIVING 

The Payroll Giving scheme allows employees to make donations to registered NZ charities and to claim a tax credit 
in their current pay, rather than at the end of tax year. Before you can record payroll giving tax credits, you need to 
set up a post‐tax deduction pay code to record donations and assign the pay code to your employees. 

Note that the payroll giving scheme is only available if you file employer schedules electronically using the file 
transfer service (ir‐File). 

Donated funds need to be transferred to charities according to IRD timing rules. To ensure payments are made 
on‐time, we recommend that you transfer funds directly to the charity at the completion of each pay. You can do 
this by including payroll giving amounts in your direct credit schedule. 
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TO SET UP A PAYROLL GIVING DEDUCTION 

1 Go to the Maintenance command centre and click Maintain Pay Codes. 

2 Click New. The New Pay Code window appears. 

3 Select the Post‐Tax Deductions pay code type and enter the pay code details. 

4 Click OK. The new code appears in the pay code list. 

5 Click the Other tab and select the This deduction qualifies for the Payroll Giving Tax Credit option. 
 

                                                    
   

NOTE :  If the payroll giving option is not active    This option is not active if you have set up the pay code to calculate 
superannuation or you have not entered a file path in the ir‐Files field (go to Tools > Options and click the Bank & IRD tab). 

 
                                                    

   

 
6 If you want to transfer funds directly to the charity at the end of each pay, select the Included in Direct Credit 

Schedule option and enter the bank account details for the charity. 

7 Complete the pay code set up as you normal do. For more information, press F1 to open the help. 
 

TO ASSIGN A PAYROLL GIVING PAY CODE TO AN EMPLOYEE 

The payroll giving tax credit pay code (PGTC) is automatically assigned to an employee's default pay when you 
assign a payroll giving deduction pay code. 

1 Go to the Maintenance command centre and click Maintain Employees. 

2 Select the relevant employee and click the Pay Defaults/Totals tab. 

3 Click New. The Select a Pay Code to Add window appears. 

4 Select your payroll giving deduction pay code and click OK. 

The selected pay code and the payroll giving tax credit pay code (PGTC) are assigned to the employee's default 
pay. 
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ACCUMULATORS TAB 

Accumulators enable you to keep track of extra information relating to the hours worked by an employee or some 
other quantity. 

 

 
 

A Apprentice hours Select this option if you use this pay code to record the number of apprentice hours 
 worked. When using this option, all the 'hours' (that is. any quantities paid for pay 

codes defined to accumulate into apprentice hours) are added to the apprentice hours 
total for that employee. 

B Accumulate 
quantities 

Select the accumulator from the list that this pay code will add or subtract from. 
Accumulators are setup using the Maintain Accumulators option from the Payroll 
menu. See ‘Maintaining Accumulators’ on page 70. 
More than one pay code can be assigned to the same accumulator.                             
For example, you may have setup a bonus for your apple pickers if they pick more than 
30 bins in a week. After adding a Bin Bonus accumulator you would assign this 
accumulator to the BINS (Gross Earnings) pay code and set it to increase the 
accumulator so you can determine if any pickers have earnt the bonus. 
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C Increase or 
decrease 

Determine whether this accumulator will increase or decrease e.g. a running total of 
bins picked will increase whereas a staff loan will decrease as it is paid off. 

  A 
 

B 

C 



 

TOTALS TAB 

The Totals tab displays monthly and year‐to‐date pay totals, and the total of the last finalised pay. These totals are 
updated when you finalise each pay and cannot be changed in the Totals tab. 

Note that you can view YTD pay code information for an employee by double‐clicking a YTD column in Pay 
Defaults/Totals tab of the employee’s details (Maintain Employees). 

 

 
 

A Monthly totals Displays the totals for the month, using the date the pay was finalised. For example, 
  if the pay was finalised 6 July then it would be included in the July figures. 

B Yearly total Shows the total for this code for the current tax year, that is, since April. 

C Total for last pay Shows the total of the last finalised pay. 
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   A 

   B 
   C 



 

 
 

Maintaining employees 
 

It is recommended that you only set up employees after you have set up other areas of your payroll. By doing this, 
you can set up default details to automatically add to new employee records. For example, when you set up pay 
codes, you can specify that the pay code is automatically added to new employees. This avoids needing to 
manually add the pay codes to each employee. 

The employee form enables you to set up and manage the various details within your employees’ records. It 
contains all your employees’ details, their individual pay defaults and leave information. 

The following topics are covered in this section: 

 Adding employees, see ‘To add an employee’ on page 46 

 Deleting employees, see ‘To delete an employee record’ on page 46 

 Editing employee details. 

In the Maintenance command centre, click Maintain Employees. 
 

 

If an employee has an active pay, a message will display when you open the Maintain Employees window. If you 
edit an employee’s pay details while a pay is active you will need to re‐enter the pay details in the active pay. 

 
SEARCH FOR AN EMPLOYEE 

To quickly find an employee, click Select Employee and select them from the list that appears. You can also use the 
arrow buttons at the bottom of the window to navigate through the list of current employees. They are sorted in 
employee code order. To view past employees as well, deselect the Hide all finished employees option in the top 
left corner. A status will appear to identify ex‐employees. 
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TO ADD AN EMPLOYEE 

1 Go to the Maintenance command centre and click Maintain Employees. 

2 Click New. The New Employee window appears. 
 

 

3 Enter a code in the Employee Code field. Each employee must have a unique code (which can be numbers or 
letters). We recommend the first four or five letters of the surname followed by the initials. This ensures that 
reports will be printed in alphabetical order for surnames. If you use numbers for your employees, make them 
the same length by including leading zeros (otherwise 11 comes before 2 alphabetically). Employee codes can 
be changed at any time. 

4 If you want to copy selected information from an existing employee, select the Copy the following 
information from Employee Code option. Press F9 to select the employee you want to copy from. Select the 
required copy options. 

5 Click OK. The first step of the New Employee Setup Wizard appears. 

6 Enter the basic pay details such as start date, IRD number and tax code. 

7 Click Next and enter the days per week and hours per day normally worked. Your normal hours per week is 
calculated. Normal hours per week is used to calculate employee leave allocation. For example, if your normal 
hours per week is 40, your employees will be allocated 4 weeks of 40 hours of annual leave per year (160 
hours). 

8 Click Next and enter the KiwiSaver details for the employee. 

9 Click Next and then Finish. 

10 Click Close. 
 

TO DELETE AN EMPLOYEE RECORD 

You can only delete an employee record if their leave balance is zero and there are no finalised pays for the current 
tax year. 

1 Go to the Maintenance command centre and click Maintain Employees. 

2 Select the employee you want to remove and click Delete. 

Note that employees that have a finish date entered in the Employment Details tab, can be removed using the 
Purge Old Data function (available from the Tools menu). 
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PERSONAL DETAILS TAB 

You enter employee details in the Personal Details tab. This information can be printed, along with the 
employee’s pay information, on the Employee Details report (see page 98). If the employee is also an owner of 
the firm, select the Working Proprietor option (this is used by the Employee Statistics, on page 98). 

 
 
 
 
 
 
 

C 

D 

 
 
 

E 
 

F 

 
 

 
B    Personal 

details 
Enter an employee’s details here. The current information can be reviewed by printing the 
Employee Details report. 

 

 
D    Contract 

Reference 
If applicable, enter a reference number for the employee's employment contract (or agreement). 

 

 
F Email pay slips If this option is selected, the employee’s pay slip will be e‐mailed to their recorded email address 

instead of printed. 
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E Password For use when emailing payslips. The password will default to the employee’s IRD number e.g. 
012345678. 

C    Permanent 
residency 

Select this option if the employee is entitled to reside permanently in NZ, and does not require a 
work permit. This determines KiwiSaver eligibility. 

A    Window tabs Access different employee details by clicking the relevant tab. 

A     

B     



 

EMPLOYMENT DETAILS TAB 

Use the Employment Details tab to enter the employee’s payroll details. 

 

 
 

 
B Dates Enter a start date when the employee began work for the company. 

If the person ceases to be an employee, enter a finish date. Note that all leave due must be zero 
before you can enter this date. 
If employment is temporary, enter date in the Employment will finish on field.                               
For information about entering dates for an employee rehired in the same payroll year, see ‘Start / 
finish dates and leave’, on page 49. 

 

 
D Round pay & 

apprentice hours 
The Round pay to nearest [X] option (where X is the minimum denomination selected, see 
‘General details’ on page 22) allows you to round the net pay to the set minimum denomination. 
Use this option when you are paying by cash or cheque, particularly if the cheque is going to be 
cashed. Any rounding is recorded and subsequent pays are adjusted, for example, if it rounds up 2c 
this pay, the next pay is rounded down accordingly. 
If apprentice hours need to be recorded, select the Apprentice hours accumulated to date option. 
Any pay codes set up to accumulate apprentice hours will be totalled in this box. When setting up 
an employee, hours already accumulated can be manually entered. 
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E Standard Hours If the employee’s standard hours are different from the default, enter it here. This is used for salary 
per Day calculations. See also Leave details, page 23. 

C Pay frequency, Pay Frequency—Choose a pay frequency from the list. Employees can have different frequencies. 
Tax Codes & IRD IRD Number —Enter the employee’s IRD Number. If no IRD Number is entered the tax code will 
number default to No Declaration. 

Tax Code —Select the employee’s tax code. This affects the tax deducted from the employee’s pay. 
If you are unsure which tax code to use, please consult the IRD. See also Entering an STC tax rate, 
page 49. 

A Default 
department 

Select a default department to assign the employee. This can be overridden during entering pay 
details if required. See ‘To add a new department’ on page 33. 

A       E 

F 
B       

G 

C       

D       



 

F Pay Rates Enter up to three pay rates. The first pay rate would normally be their basic hourly rate. Pay codes 
can be set to use a specific pay rate. Do not use the other rates for overtime or pay rates that are 
multiples of the basic rate, use ORD1.5 or ORD2 pay codes instead. Also see ‘Annual salary and pay 
rates’ below. 

 

 
 

ANNUAL SALARY AND PAY RATES 

If the employee is paid a salary, you can enter it in the Full Time Equivalent Salary field. The pay rate will 
automatically be calculated based on this figure. If there is no annual leave entitlement, you can change the pay 
rate unit; hours, days or weeks. The pay rate will adjust accordingly. For information on changing the calculation 
basis see ‘Salary Calculations’, on page 22. 

 
ENTERING AN STC TAX RATE 

If an employee has an STC (Special Tax Code) certificate from the IRD, you enter the STC rate in the Tax Rate % field 
on the Employment Details tab. 

Note that the STC rate includes the ACC Earner Levy. As MYOB Payroll calculates ACC Earner Levy separately, you 
need to enter the STC rate exclusive of the levy. For example, if the employee’s STC rate is shown as 22%, then 
deduct your ACC Earner Levy (1.39% at the time of publishing), and enter the result (20.61%) in the Tax Rate % 
field. 

 

 
 

START / FINISH DATES AND LEAVE 

If a casual employee (that is, an employee that is only entitled to holiday pay and not annual leave) returns later in 
the year, the finish date can be deleted and a new start date entered. 

If a permanent employee (that is, an employee entitled to annual leave) returns later in the year, you will need to 
set up a new employee record for this employee. As the annual leave calculation depends on the employee's start 
date and leave anniversary date, this ensures leave is correctly calculated. 

You can use the Reason for Leaving field to record details of an employee’s departure if you want to maintain this 
information for reporting purposes. 

The finish date and reason for leaving details can be viewed on the Employment Details tab, and can be printed 
using the Staff Turnover report. All employees with a finish date can be removed by using the Purge Old Data 
option available from the Tools menu. 

 For more information on how leave is calculated see ‘Processing employee leave’ on page 61. 

 For information on processing an employee’s final pay, see ‘Preparing final pays’ on page 82. 
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G Bank Account Enter a bank or credit card account if the employee is paid by direct credit. A two digit suffix is 
acceptable. Enter the particulars, code and reference that the employee wants to show on their 
bank statement. To enter more than one bank account for an employee, see ‘To set up multiple 
bank accounts for an employee’ on page 41. 



 

PAY DEFAULTS / TOTALS TAB 

The pay defaults allow you to streamline your payroll processing, as you can set the pay defaults to be an 
employee's standard pay. 

 

 
 

 
B  Quantity The quantities entered are defaults only and can be changed when processing pays. These are the pay 

details that will be entered when you use the Calculate Default Pays option. Codes which are not based on 
an employee’s pay rate are generally set to one. 
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C   Rate If the pay code rate is based on an employee’s pay rate or uses a default pay rate, it cannot be edited here. 
If the pay code allows it, it can be edited while entering the employee’s pay details. 

A  Pay code &    The pay codes that appear in this window are included as the default pay for the employee. 
description    Pay codes with the Use this Pay Code for all new employee option selected are automatically added to new 

employees (for more information, see ‘General tab’ on page 37). 
You can add or remove pay codes, as required. 

A B C D E 

F 



 

D  Type You can select one of the following types: 
• Variable (V) is the default type and will apply for most pay codes. It is used where the rate or the quantity 

will vary from pay to pay. Use this type when the rate or quantity is automatically calculated (such as tax). 
• Regular (R) is used for defaults that are fixed amounts from pay to pay, such as a fixed amount to be paid 

to a bank account. For example, if an employee wants $100 paid to one bank account and the balance 
paid to other account, you would set up two payment pay codes; a Regular type pay code with a fixed 
payment of $100 and a Variable type pay code to record the balance. (Note that if an employee has more 
than one payment default, only one pay code can be variable, the others must be regular.)                 
Note that changing pay codes to the Regular calculation type that need to be automatically calculated 
(such as the TAX code), will suppress the calculation. You need to use the Variable type for these pay 
codes. 

• Old (O) is used for defaults that are no longer used but cannot be deleted. These are not visible when 
entering pay details. 

To select a pay type, enter the first letter of the type you want to use; V (variable), R (regular) or O (old). 
 

 
F   Split 

Default 
Create a default department split for the selected pay default. Use this option where the cost of a pay code 
is allocated between more than one department. You can modify the split amount when entering pay 
details. For more information see ‘To split pay defaults across departments’ on page 52. 

 
 

The columns in the Pay Defaults/Totals window can be rearranged by clicking a column heading and dragging to a 
new position. Column widths can be changed by clicking and dragging the divider between column headings. 

 
TO ADD A PAY DEFAULT 

1 Go to the Maintenance command centre and click Maintain Employees. 

2 Select the required employee. 

3 Click the Pay Defaults/Totals tab. 

4 Click New. The Select a Pay Code to Add window appears. 

5 Select a pay code and click OK. The pay code appears in the default code list. 

6 If required, enter the default details. 
 

                                                    
      

NOTE :  Adding a pay default when entering pays    You can add a pay default when entering a pay by clicking Add Default in the Enter 
Pays window. 

 
                                                    

      

 

TO REMOVE A PAY DEFAULT 

You cannot delete a pay default that has a current year total. If you no longer use the pay default, change the Type 
to Old (press O). These are not visible when entering pay details. 

1 Go to the Maintenance command centre and click Maintain Employees. 

2 Select the required employee. 

3 Click the Pay Defaults/Totals tab. 
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E   Totals The Quantity YTD and Gross YTD are updated after every pay is finalised. For more detail, double‐click a YTD 
column to print an employee, pay code specific report. 



 

4 Select the pay code you want to remove. 

5 Click Delete. A confirmation message appears. 

6 Click Yes. 
 

TO SPLIT PAY DEFAULTS ACROSS DEPARTMENTS 

The Split Default function is used to split the cost of an employee’s pay code between multiple departments. For 
example, if an employee splits their time between the Auckland and Christchurch offices, you would use the Split 
Default function. 

1 Go to the Maintenance command centre and click Maintain Employees. 

2 Select the required employee. 

3 Click the Pay Defaults/Totals tab. 

4 Select the pay code you want to split. 

5 Click Split Default. The Permanent Department/Costcentre Splits for window appears for the selected pay 
code. 

Note that some pay codes, such as TAX, cannot be split for cost analysis. 
 

 

6 Press F9, select the department you want to assign and click OK. The department is added to the list. 
Note that the department is given a ‘P’ type to indicate that the split is permanent. Pay code splits entered 
when preparing an pays are given a ‘T’ (temporary) type. 

7 Enter the quantity of units (such as hours). 

8 Click New to add another department row. 

9 Repeat from step 6 above for each department you want to add. 

10 Click OK. The Pay Defaults/Totals window appears. 
 
 

LEAVE DETAILS TAB 

Maintaining leave information is discussed in detail in ‘Processing employee leave’ on page 61. 
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NEXT OF KIN TAB 

It is important to keep these details up‐to‐date, particularly for emergency purposes. 
 
 
 
 
 

A 

 
 
 
 
 
 
 
 

 

 
B    Alternative 

Contact 
Details 

Use this text box to list another contact, preferably someone who does not live 
with the employee. Press Ctrl+Tab to exit or click outside of the text box. 
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A    Next of Kin 
details 

Next of Kin is the person most closely related by blood to the employee. The 
emergency contact can be the same person. However, this will depend on the 
employee’s preferences. 

B 



 

QUALIFICATIONS & NOTES TAB 

The Qualification and Notes fields allow you to record additional employee details. 

 

 
 

 
B   Notes Record any other payroll issues specific to that employee, such as pay‐rise 

dates. You can also enter notes from the Enter Pay Details window. 
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A   Qualifications   Use the Qualifications field to record an employee's qualifications including 
any training courses attended. This is useful if an employee reference is 
needed. 

A B 



 

PAY HISTORY TAB 
 
 

 
 

 
B   Reprint pay 

slip 
Double‐click a pay to reprint the pay slip. It is an exact recreation of the pay 
slip, however the employee’s address and tax code will be current. These 
reprinted pay slips cannot be printed on secure pay‐slip stationery. 
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A   Pay details All finalised pays are listed for the current year. These details cannot be 
edited. The Round column shows any rounding details for this pay. 

A B 



 

COMPULSORY DEDUCTIONS TAB 

Use this tab to manage compulsory deductions from the employee's pay. 

CAUTION :  Authorisation required     Only use this tab when provided with the appropriate letters from institutions listed below. MYOB 
Payroll will apply the rules based on the information entered to calculate the correct deduction amounts. 

 
     

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

B   Inland 
Revenue 
Arrears 

 
                                                
   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Enter the original sum of the amount owing. The IRD pay code is automatically added to the employee’s 
pay defaults, see page 50 (IRD rates are used). On the next pay run, the IRD Pay Code will show the balance 
owing, and either calculate 10% of the total amount owing, or 20% of the employee’s gross earnings ‐ 
whichever figure is less. This amount will be automatically calculated and deducted from the balance 
owing after each pay run. 
The amount will automatically stop being deducted when the total amount has been paid. 
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A 

B 
 
C 

D 
 
 
E 

A   KiwiSaver If an employee starts after 01/07/2007, the Eligible for KiwiSaver option is automatically selected. 
Employees must opt‐out if they do not want to join KiwiSaver.                                                                             
If an employee started before 01/07/2007 and they want to join KiwiSaver, you need to manually select this 
option. 
If the option is not available, check their Personal Details tab to make sure they meet the scheme criteria 
(for example, they must be 18 or older and a permanent resident). 
Employees can stop making contributions for up to five years, if they have been a member for 12 months 
or longer. 
Note that newly hired casuals are not automatically enrolled into KiwiSaver, you need to opt them in 
manually. 



 

 

 
D   WINZ  Enter the WINZ customer reference provided by the employee or WINZ. The ISS pay code is automatically 

added to the employee’s pay defaults, see page 50, and sets the quantity to one. Set the rate for this pay 
default to the amount to be deducted each pay. 
When notified to stop deducting these amounts, change the pay code rate to 0 and the type to Old. 
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E    Student Select SLCIR (Commission deduction) for additional student loan deductions, which have been ordered by 
Loan the IRD. Enter the details of the payment, as instructed by the IRD. Select SLBOR (Borrower deduction) for 
Deductions    additional student loan deductions made voluntarily by an employee. Enter the details of the payment. 

C    Dept of 
Courts 

Enter fine amount into the Fines in Default field. If your employee has a Fines Number or a CID Number, 
enter these into the relevant fields. The COURT pay code is automatically added to the employee’s pay 
defaults, see page 50, and sets the quantity to one. Set the rate for this pay default to the amount to be 
deducted each pay. The amount will be deducted at this rate, or part thereof if the net pay is less than the 
protected net earnings. The amount will automatically stop being deducted when the total amount has 
been paid. 



 

KIWISAVER ELIGIBILITY FLOWCHART 
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ACCUMULATORS TAB 
 

 

When you have set up an accumulator (see ‘To add an accumulator’ on page 71), you can add it to an employee 
and enter an opening balance, if required. 

Note that apprentice hours are setup on the Employment Details tab. For more information, see ‘Employment 
Details tab’ on page 48. 

 
TO ADD AN ACCUMULATOR TO AN EMPLOYEE 

1 Go to the Maintenance command centre and click Maintain Employees. 

2 Select the required employee. 

3 Click the Accumulators tab. 

4 Click New. The Select an Accumulator list appears. 

5 Select an accumulator and click OK. 

6 [Optional] Enter a balance. 

For accumulators that increase (such as long service leave), the balance would usually be zero. For 
accumulators that reduce (such as a staff loan), enter the opening balance that will be deducted from. 
Negative amounts can be used. 

 
TO REMOVE AN ACCUMULATOR FOR AN EMPLOYEE 

The accumulator balance must be zero before it can be deleted. 

1 Go to the Maintenance command centre and click Maintain Employees. 

2 Select the required employee. 

3 Click the Accumulators tab. 

4 Select an accumulator. 

5 Click Delete. A confirmation message appears. 

6 Click Yes. 
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REMINDERS TAB 

Use this tab to manage reminder alerts for future actions. Reminders that are due are displayed when the payroll’s 
current pay date is updated. 

 
 

 
 

 
B Status An Active status indicates the reminder is still in use. The Completed status is for reminders 

that are no longer required. 
 
 

TO SET A REMINDER FOR AN EMPLOYEE 

1 Go to the Maintenance command centre and click Maintain Employees. 

2 Select the required employee. 

3 Click the Reminders tab. 

4 Click New. The Maintain Reminders window appears. 

5 Enter details of the reminder, such as the date you wish to reminded on, a brief description of the action 
required and related notes. 

6 The status will default to Active. 

7 Click OK. 
 

TO EDIT A REMINDER FOR AN EMPLOYEE 

1 Go to the Maintenance command centre and click Maintain Employees. 

2 Select the required employee. 

3 Click the Reminders tab. 

4 Double‐click a reminder. The Maintain Reminders window appears. 

5 Update the details as required and click OK. 
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A Reminder details The date the user will be alerted and a brief description of the action that needs to be taken. 

A B 



 

TO DELETE AN REMINDER FOR AN EMPLOYEE 

1 Go to the Maintenance command centre and click Maintain Employees. 

2 Select the required employee. 

3 Click the Reminders tab. 

4 Select the reminder you want to delete. 

5 Click Delete. A confirmation message appears. 

6 Click Yes. 
 
 
 

 

Processing employee leave 
 

This section explains how to use MYOB Payroll to calculate employee leave and provides some background on 
leave entitlements (‘General Leave information’ on page 65) and where you can go for more information 
(‘Additional resources’ on page 65). 

If you are unfamiliar with any leave‐related terms, see the ‘Glossary’ on page 69. 
 
 

MANAGING LEAVE WITH MYOB PAYROLL 

When a permanent employee starts work, and up until their first anniversary of employment, they accrue holiday 
pay at a minimum of 8% of their gross earnings. (8% equates to an entitlement of four weeks annual leave once 
they have worked a full year.) 

At their holiday anniversary, holiday pay is converted to annual leave and reset to zero. The annual leave becomes 
due at their average weekly earnings divided by their normal time per week (hours, days) or their normal pay rate, 
whichever is higher. (You can manually check the holiday anniversaries that need updating by selecting Holiday 
Anniversary from the Tools menu.) 

Holiday pay starts accruing again on the next year’s earnings. Annual leave may be taken in advance at the 
employee’s calculated annual leave pay rate, using the ANHL pay code. If the employee ceases employment, they 
will be due for any holiday pay that has accrued since their last anniversary date, plus the balance of annual leave 
(which may be a negative quantity if leave has been taken in advance). 

Casual employees are not entitled to annual leave. Instead, holiday pay is paid out with each pay, or at the end of 
each period of employment. Any holiday pay accrued at their anniversary date is carried forward to their next year 
of employment. 

You set up and monitor annual leave, holiday pay, sick leave and leave‐in‐lieu in the Leave Details tab of the 
Employee Maintenance window. The Leave Details tab has two sub sections: 
 Annual Leave & Holiday Pay tab, page 62 

 Other Leave tab, page 63. 
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ANNUAL LEAVE & HOLIDAY PAY TAB 

A 

B 

C 

D 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

B    Holiday 
Anniversary 
Date 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

MYOB Payroll defaults to each employee having their own individual anniversary date for calculating 
annual leave entitlements. For a new employee, this will default to one year from the employee’s start 
date. The anniversary date can be changed, but may require the employee’s other leave information 
to be manually adjusted. 
If you have selected the option to use a common anniversary date, the common anniversary date is 
shown (see ‘Leave details’ on page 23). Annual leave entitlements for all employees are calculated 
and due at that date. 
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C    Gross Earnings    Enter the employee’s gross earnings since their last anniversary date. This will be zero for new 
since employees. Enter the percentage that holiday pay accrues at during the year. 

For permanent employees, multiply the gross earnings by the holiday pay percentage to get the 
current balance of holiday pay due. 
For casual employees, enter the balance of holiday pay that has not yet been paid out. Holiday pay 
due will be zero for new employees. 
The gross earnings field is updated each time a pay is finalised and is based on pay codes with the type 
gross earnings. 

E 

A   Normal work Enter the normal days and hours worked per week. This figure is used to allocate annual leave and for 
arrangement the calculation of leave rates. If an employee’s work hours are highly variable, it is preferable to enter 

the minimum number of hours worked, rather than the maximum hours. In this case, additional hours 
worked will be reflected in their annual leave pay rate. If hours worked are overestimated, additional 
hours of leave will be allocated to the employee leave balance, but the leave will be paid at their 
normal rate. As such, their entitlement will be inflated. 
For casual employees, do not set them up with any normal time per week.                                        
Note that the unit of measurement is determined by the pay rate section on the Employment Details 
tab. 



 

D   Annual Leave 
due 

Enter the balance of annual leave due at the time the payroll is set up. You will need to manipulate this 
figure until the figure in the Current Annual Leave due field is correct. 
Enter the pay rate that this leave is due to be paid at so that the correct value of annual leave is 
displayed. This rate can not be less than the employee’s normal pay rate. 

 

 
 

OTHER LEAVE TAB 
 
 
 
 

A 
 
 
 
 
 

B 
 

C 
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A   Sick Leave, 
(see also ‘Sick 
leave’ on 
page 68) 

Sick Leave is a minimum of five days per year after the first six months of service. Employers can 
agree to more than this. Whenever the SICK pay code is used this balance is updated.            
Next Sick Leave Anniversary Date ‐ Sick leave anniversary updates are separate to annual leave 
updates. You will be prompted to update when sick leave anniversaries are met. For new 
employees, the sick leave anniversary date will default to six months after their start date. 
Each employee has: 
• Current Sick Leave due (zero, if new) 
• Maximum Sick Leave Entitlement—This is the maximum amount of sick leave that can be 

accumulated (zero, if there is no maximum) 
• Annual Sick Leave Entitlement—This is recorded in days and paid at an employee’s normal pay 

rate. 
If you are setting up sick leave for a new employee whose entitlement is per the Act, enter: 
• Annual entitlement of 5 (days) 
• Maximum entitlement 20 (days). 

E    Annual Leave Click the ellipsis to view how the employee’s leave rate is calculated. It is based on the preceding 12 
rate months gross earnings. If no pay history exists, you will need to manually override this amount or use 
calculation the Enter History option (Tools menu), see Entering pay history, page 110. For details on calculating 

these amounts, refer to the F1 online help. 

D 



 

B   Alternative 
Holidays due 

This is the number of days that the employee has owing for working on public holidays (the day 
credited for working a public holiday is known as an Alternative Holiday), which can be taken 
sometime in the future. When setting up a new employee this will be zero. When setting up an 
existing employee, enter the outstanding balance. When the LIEU pay code is used, this balance 
will be updated. 
Note that the LIEU pay code should only be used for alternative holidays. If you need to record 
time off in lieu, use the TOIL (Time off in lieu) pay code and add the TOIL accumulator to the 
employee (see Accumulators tab, page 43). 

 

 
D   Employment 

Relations 
The fields in the Employment Relations section concern the requirements of the Employment Act 
relating to collective contracts. Enter in the contract title, expiry date, employment relations 
education leave due, and the relevant expiry date. 
A pay code (EREL) has been added for employment relations education Leave. 
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C    Parental 
Leave 

Record the start and end dates of the employee’s leave in these fields. 
You can run the Parental Leave details report from the Reports >Employee Reports menu. This 
provides you with the required information to complete the IR880 form. 



 

ADDITIONAL RESOURCES 

The Department of Labour has provided many helpful publications to assist with understanding your obligations 
as an employer. Visit www.dol.govt.nz for publications and fact sheets that clearly explain what employees are 
entitled to and how to calculate these entitlements. 

 
 

GENERAL LEAVE INFORMATION 

Employers and unions or employees can agree to better annual leave rights than those in provided in the Holidays 
Act, but not to less. Many employment agreements, for example, give employees extra leave entitlements after 
they have worked for the same employer for a number of years. 

We recommend that you review your employment agreements in light of changing legislation to make sure they 
are legal. For example, check that the following are covered: 

 Ordinary weekly pay amount 

 Relevant daily pay amount 

 How unpaid leave is managed. 
 

ACCIDENT COMPENSATION 

An employee injured doing their work and is unable to work, is entitled to be paid compensation by their 
employer for loss of earnings in the first week following the injury. This is 80% of the earnings lost as a result of not 
being able to work. After the first week, ACC pays the compensation and will provide other assistance to get the 
employee back to work as soon as possible. 

An employee who is injured outside work is not entitled to loss‐of‐earnings compensation from their employer for 
the first week. 

Ask the nearest ACC office for more information about what you are eligible for after an injury. 
 

ANNUAL LEAVE 

The Holidays Act gives all employees rights to paid annual leave, whether they are full‐time, part‐time, fixed‐term, 
temporary or casual employees, adults or young employees. Employees are not lawfully able to agree to give up 
these rights. 

Employees are entitled to at least four weeks paid leave after they have worked continuously for the same 
employer for 12 months. 
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http://www.dol.govt.nz/


 

ANNUAL LEAVE RATE CALCULATION 

While MYOB Payroll has been designed to automate much of the process of annual leave rate calculation, it is 
worthwhile knowing how the process works. 

The following diagrams shows how the two major rates—annual leave rate and relevant daily pay—are calculated. 
 

 
 

CHRISTMAS AND SEASONAL SHUTDOWNS 

If an employer has a closedown period (for example, for Christmas or at the end of a season), employees who have 
not been employed for 12 months can agree to take annual leave in advance or have their accrued holiday pay 
balance paid out. If the holiday pay balance is paid out, the employee's leave anniversary date should be reset to 
12 months from the shut down date. Some business can simplify this process by using a common anniversary 
date. 
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ANNUAL LEAVE 

For each unit of paid annual leave, employees are paid the larger of: 

 their average weekly earnings or 

 their ordinary weekly pay. 

Holiday pay should be paid before the employee's holiday starts. 

In some limited circumstances, for example casual employment, the Courts have allowed holiday pay to be paid on 
a 'pay as you go' basis. However, your employee's agreement to this should be clearly recorded in writing, in order 
to show that they understand this arrangement. 

 
HOLIDAY PAY AT THE END OF EMPLOYMENT 

When finishing employment, employees are entitled to be paid any remaining balance of annual leave and any 
remaining balance of holiday pay. See To calculate a final pay, page 82. 

 
PUBLIC (STATUTORY) HOLIDAYS 

By law, every employee is entitled to not less than 11 public holidays each year, which should be paid holidays for 
the employee when they fall on days of the week on which the employee would normally work. 

Public holidays are in addition to paid annual leave days. There are two groups of holidays, with slightly differing 
entitlements applying to each: 

 Christmas and New Year: Christmas Day (25 December), Boxing Day (26 December), New Year's Day and the 
day after (1 and 2 January) 

 All other holidays: Waitangi Day (6 February), Good Friday and Easter Monday (dates variable), ANZAC Day (25 
April), Queen's Birthday (first Monday in June), Labour Day (fourth Monday in October) and Provincial 
Anniversary Day (date determined locally). 

 
RECORD KEEPING 

Employers must keep records of annual holidays for six years. The following information must be kept: 

 the employee's name 

 the date on which the person's employment started 

 the date the person's employment ended 

 the date on which the employee becomes entitled to each annual holiday 

 the dates on which the employee takes the holidays 

 the amount of money paid for each holiday 

 the amount of money paid to the employee for annual holidays when the employment ends. 

These records can be incorporated in the wages and time records which employers must also keep. Employees 
and their representatives and Labour Inspectors have the right to see these records. 
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RELEVANT DAILY PAY 

MYOB Payroll includes a calculation of relevant daily pay. To access this calculation window, go to the Prepare Pays 
command centre, click on Enter Pays, double‐click an employee and click the Leave button. Then click the ellipsis 
beside the normal pay rate showing for alternative holidays. 

 

 

This window allows you to change the rate used for paying alternative holidays (or leave in lieu), bereavement or 
sick leave. Click the ellipsis to change the relevant daily pay. The rate used must be the greater of the relevant daily 
pay amount specified in the employees' employment agreement or what they would have earned had they 
worked that day (using the Based on earnings method). 

If the Based on earnings method does not show a clear relevant daily pay, then the average daily pay calculation 
can be used instead. Average daily pay is based on earnings from the last 52 weeks, divided by the number of days 
worked. (Note that prior to 1 April 2011, average daily pay was based on earning from the last four weeks.) The 
number of days worked is an estimate based on the employees leave settings; you can adjust the calculation. 

 
SICK LEAVE 

By law, after working for the same employer for six months, an employee has the right to five days paid sick leave 
for each subsequent 12‐month period. Sick leave can be used by an employee for any of the following: 

 sick leave 

 domestic leave to care for a sick spouse, dependent child, or dependent parent of the employee, or of the 
employee's spouse 

Unused sick leave can be carried over into the next year, up to a maximum of 20 days (including the current year’s 
entitlement). Employment agreements can have more sick leave than provided for by law. They must not provide 
for less. Employers and employees or unions can also agree that other types of paid or unpaid leave will be 
included in the agreement. 

 
TIME OFF IN LIEU 

A time off in lieu (TOIL) pay code is used to track time off in lieu, as distinct from alternative holidays tracked in the 
Other Leave tab for an employee. 
If the TOIL code is added to the default pay setup for an employee, any hours over the standard pay default hours 
(such as 40 hours) worked are credited to the TOIL running total, and any hours under the pay default standard 
hours worked are deducted from the TOIL total to make up the standard hours (for example, if only 38 hours are 
worked, then 2 taken from TOIL to make up the standard 40). 

The TOIL pay code can be overridden in the Enter Pays window. 
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UNPAID LEAVE 

When an employee takes unpaid leave of more than a week during the year, this can be managed in three ways: 

 The employer can choose to extend the time required before the employee becomes entitled to annual 
holidays by the period of unpaid leave in excess of one week. 

 The employer and employee can agree that an employee's average weekly earnings calculation will be 
modified to reflect the number of whole or part weeks greater than one week that the employee was on 
unpaid leave. 

 The employer and employee can agree that the unpaid leave will have no effect on the employee's annual 
holiday entitlement. 

Time while an employee is on ACC, parental leave or leave for voluntary military service does not affect the 
anniversary date for annual holiday purposes. 

 
ENFORCEMENT OF HOLIDAY AND LEAVE RIGHTS 

Employees (or their unions or representatives) can find out about enforcing any rights for leave under the law or 
their employment agreements by contacting Employment Relations Infoline. 

Statutory rights to annual leave, public holidays and special leave can be enforced by the Labour Inspectors. They 
may investigate complaints and act to recover any money owing to employees. 

 
GLOSSARY 

(see also the ‘Glossary’ on page 115) 
 

 
Alternative Holiday Previously known as Leave‐in‐lieu, this is a day off given to an employee who works a Public 

Holiday. Payment is at the employee’s Relevant daily pay. 
 

 
Annual Leave pay What an employee is paid when on annual leave. Entitlement falls due after 12 months 

employment. Can be taken in advance. Outstanding annual leave will be paid out if 
employment is terminated. 

 

 
Average weekly 
earnings 

Average weekly earnings are determined by calculating gross earnings over the 12 months 
prior to the end of last payroll period before the annual holiday is taken, and dividing that 
figure by 52. (Note that prior to 1 April 2011, this was based on earning from the last four  
weeks.) 
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Bereavement Leave Previously included with Special Leave, this is now a separate entitlement. All employees are 
entitled to three days paid leave (after six months service) when they suffer the loss of an 
immediate family member. This leave does not need to be used immediately or on 
consecutive days. One day paid leave for a bereavement suffered outside of the immediate 
family (at the employer’s discretion). Payment is at the employee’s relevant daily pay. 

Annual Leave rate The greater of the employee’s average weekly earnings or ordinary weekly pay is used to 
calculate what an employee is paid while taking annual Leave. If this method does provide a 
clear picture of their ‘average’ pay, then an average of the last four weeks earnings can be 
used. 

Annual leave An entitlement to at least four weeks paid leave after working continuously for the same 
employer for 12 months. 

Term Explanation 



 

Holiday Pay An accrual of leave based on a percentage of the employees gross earnings. May be paid to 
casual employees or when preparing a final pay. 

Public Holiday 
(Statutory Days) 

Officially recognised days that employees are entitled to paid leave on, if it is a day they 
normally work. This is in addition to their annual leave entitlements. 

 

 
Sick Leave Previously included with Special Leave, this is now a separate entitlement. All employees are 

entitled to a minimum of five days Sick Leave a year (after six months service), accumulating 
to a maximum of 20 days. Payment is at the employee’s relevant daily pay. 

 

 
Time‐and‐a‐half The increased minimum payment for employees working a Public Holiday. For example, if 

the employee is paid an hourly rate, then he or she is entitled to one‐and‐a‐half times that 
rate for the time worked on a public holiday, as in the following clause: “The pay rate for this 
position is $12 per hour. For time worked on a public holiday, the pay rate is $18 per hour 
(time‐and‐a‐half).” 

 
 

 
 

 

Maintaining Accumulators 
 

Accumulators are useful for keeping track of extra information relating to the quantities (units) of one or more 
employee pay codes. 

For example, you may want to keep track of an increasing total of fruit bins picked for a season or a decreasing 
total for a staff loan. Add an accumulator called BINS. Assign it to the relevant pay code then add it to the 
employee. When the next pay is processed the total quantity of bins entered when calculating the pay will be 
recorded against the employee. Subsequent bin quantities will be added to this total. 

To open the Maintain Accumulators window, select Maintain Accumulators from the Payroll menu. 
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Special Leave This entitlement was made obsolete with the introduction of the Holidays Act 2003. Any 
outstanding Special Leave entitlement will be converted to Sick Leave. 

Relevant daily pay This is the amount an employee is paid when taking Sick or Bereavement Leave or working a 
Public Holiday. This amount is usually specified in the employment agreement and is 
basically what the employee would’ve received had they worked. If unclear, an average 
taken from the last 52 weeks earnings may be used. (Note that prior to 1 April 2011, this was 
based on earning from the last four weeks.) 

Ordinary weekly 
pay 

Ordinary weekly pay represents everything an employee is normally paid weekly, based on 
their pay defaults or normal pay (normal time x normal pay rate). 

Term Explanation 



 

TO ADD AN ACCUMULATOR 

1 From the Payroll menu, choose Maintain Accumulators. The Maintain Accumulators window appears. 

2 Click New. The New Accumulator window appears. 

3 Enter a code and a description. This will appear on the employee’s pay slip if this option is selected. 

4 Click OK. 
 

TO DELETE AN ACCUMULATOR 

You can only delete an accumulator if there are no active pays and the accumulator is not used by any employees. 

1 From the Payroll menu, choose Maintain Accumulators. The Maintain Accumulators window appears. 

2 Select an accumulator and click Delete. A confirmation message appears. Click Yes. 
 

TO USE AN ACCUMULATOR 

1 Add an accumulator (see ‘To add an accumulator’ above). 

2 Go to the Maintenance command centre and click Maintain Pay Codes. 

3 Add or edit a pay code for which quantities need to accumulate. 

4 Click the Accumulator tab and specify the accumulator to which any quantities paid using this pay code will 
accumulate. See ‘Accumulators tab’ on page 43. 

5 Go to the Maintenance command centre and click Maintain Employees. 

6 Select a relevant employee 

7 Click the Pay Defaults tab and add the relevant pay codes to the pay defaults. See page 50. 

8 Click the Accumulator tab. 

9 Enter a current balance (if applicable) and specify if the balance will print on the employee's pay slip. See 
‘KiwiSaver Eligibility flowchart’ on page 58. 

 
 

EXAMPLE OF HOW ACCUMULATORS CAN BE USED 

If an employee is entitled to one week (40 hours) of Long Service Leave. 

1 Create the accumulator LSL, (Long Service Leave). 

2 Create a pay code called LSL, (Long Service Leave). This enables employees to be paid long service leave, based 
on the employee's normal pay rate multiplied by 1. On the Accumulators tab, specify the LSL accumulator. 
Specify that it is to decrease so that the balance of LSL is reduced when some LSL is paid. 

3 Add the LSL pay code to an employee’s pay defaults. 

4 Add the LSL as an accumulator for the employee. Specify the balance due to the employee and mark to show 
the balance on the pay slips. 
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3 Preparing pays 
This chapter describes how to import, enter and print timesheet details, calculate default 
pays, enter pay details and print pay slips. 

 
 
 

 

Overview 
 

The Prepare Pays command centre provides all the options associated with entering pay 
details. 

 

 

You only need to complete the tasks relevant to your business. 
 

 
Import timesheets page 74 

 

 
Print timesheets page 77 

 

 
Enter pays page 78 
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Print pay slips page 84 

Calculate default pays page 77 

Enter timesheets page 75 

To do this… See… 



 

 
 

Importing timesheets 
 

Timesheets can be imported from any other system that creates a file in the correct format. The file 
must be a comma‐delimited type, which can be easily created from Microsoft Excel by using the Save 
As option, or by exporting in this format from other timesheet software. Detailed specification about 

the file format required are described in the F1 help topic Import timesheets. 
 

TO IMPORT A TIMESHEET 

1 Go to the Prepare Pays command centre and click Import Timesheets. The Import Timesheets window 
appears. 

2 Locate the file you want to import by entering a valid file path, or use the ellipsis […] to search for the file. 
 

 

3 If the import file contains pay codes that are not currently set up as pay defaults for the employees you are 
importing for and you want these pay codes added to the employee’s pay defaults then select the 
Automatically create a pay default if a pay code is invalid for an employee option. If this option is not 
selected, then errors are generated for any lines with non‐default pay codes. 

4 Click Import. 
 The import file is read and checked for errors. Errors include invalid employee codes, pay codes, departments, dates 

or quantities. If errors are found, you are prompted to print a report of the errors, and given the option to abandon 
the import (to go back and correct the original file) and re‐import, or to accept the import excluding any errors. 

 If a file is imported successfully, it is renamed with a new file extension (for example, the first file will have an 
extension of ‘.001’, the second with ‘.002’, etc. These historical files can be imported again if needed). 
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5    After the timesheet lines have been imported they can be viewed, edited or deleted in the Enter Timesheets 
window. 

 

 
 
 
 

 

Entering timesheets 
 

You can enter timesheets directly in your software using Enter Timesheets. You can also use this 
function to edit or delete imported timesheet details. 

You might enter timesheets when: 

 an employee’s recorded time appears on more than one source document 

 a number of employees require their pays to split across multiple departments 

 times are entered on a part period basis (For example, daily for a weekly pay or weekly for a fortnightly pay). 
 
 

TIMESHEET ENTRY OPTIONS 
 

 

 Prompt for Department/Costcentre—Select to override the employee’s default department/cost centres. 

 Prompt for date—The date defaults to the current pay end date, displayed at the bottom right of the payroll 
screen. Select to enter specific dates. 

 Default new entries to the previous entry—Select to repeat the employee code and pay code (and 
Department/Costcentre codes if Prompt for Department/Costcentre is selected). This may be useful if you 
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have a lot of timesheet information for the one employee, or the same pay code or the same department/cost 
centre. 

 Enter timesheets by batches—Select to keep groups of timesheet entries together. All entries can be viewed 
by selecting their batch number or select zero to view the complete list. 

 
TO ADD A TIMESHEET ENTRY 

1 Go to the Prepare Pays command centre and click Enter Timesheets. The Enter Timesheets window appears. 

2 Click New. The date appears by default. 
 

 

3 In the Employee column, press F9 or TAB and select the employee. 

4 In the Pay Code column, press F9 or TAB and select the required pay code. 

5 In the Quantity column, enter the unit amount for the pay. 

6 Click New to add a new timesheet entry. 

7 Repeat from step 3 for each employee. 

8 Click Close. 
 

TO EDIT A TIMESHEET ENTRY 

 Locate and select the transaction line and change the details as required. 
 

NOTE :  Override employee defaults    Timesheet entries will override the employee’s default quantities set up in Maintain Employees 
(Pay Default Totals tab). 

 
 

TO DELETE A TIMESHEET ENTRY 

There are two ways to delete a timesheet entry. 

 Select the timesheet line you want to delete and then click Delete. 

 Select Delete All to clear all timesheet information from the selected batch if the Enter timesheets by batches 
option is selected, otherwise timesheet entries from all batches will be deleted. 
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Print timesheets 
 

You can print a report that shows all the timesheet entry information for employees. You can print this 
report by employee or by batch. 

 
TO PRINT TIMESHEETS 

1 Go to the Prepare Pays command centre and click Print Timesheets. The Print Timesheets Details window 
appears. 

 

 

2 Select how you want to view the report information: by employee or batch. If you select batch, the report will 
print by batch number, and then by employee code. 

3 Select what information you want to include in the report and click Next. 

4 Select the employees you want to view information for and click Next. 

5 Click Preview to display the report on screen, or click Print. 
 
 
 

 

Calculate default pays 
 

Calculating default pays is a quick way to prepare standard or normal pays for your employees based 
on the payroll details you have set up for them. (see ‘Pay Defaults / Totals tab’ on page 50). 

Pay defaults are useful if most of your staff are paid the same each pay period. But if the pays for most 
of your employees varies from pay to pay, you may choose not to use this option. 
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TO CALCULATE DEFAULT PAYS 

1 In the Prepare Pays command centre, click Calculate Default Pays. The Calculate Pays window appears. 
 

 

2 Choose a pay frequency: 
 

Daily 4 Weekly 
 

 
Fortnightly Annually 

 

 
3 Weekly Timesheets 

 
 

Note that if the Timesheets frequency is chosen, only those employees for whom timesheet details have been 
entered will be calculated (whatever their pay frequency). 

3 If you want to calculate another pay frequency, repeat this procedure. 
 
 
 

 

Enter pays 
 

Enter pays is the main method of entering pay information. It is used for reviewing and modifying pays 
prepared using the Calculate Default Pays option and for preparing pays directly. 
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Half Monthly Variably 

Weekly Monthly 



 

Once a pay has been prepared (entered or calculated) for an employee, an ‘X’ is displayed in the Active column 
and the pay is referred to as an active pay. To enter (prepare or activate) an employee’s pay, either select the 
employee or double‐click the employee. 

 

 
 

TO EDIT PAY DETAILS 

1 Go to the Prepare Pays command centre and click Enter Pays. The Enter Pays window appears. 

2 Double‐click the employee to enter (prepare or activate) an employee’s pay. The Enter Pays Details window 
appears. 

A standard pay is calculated based on the employee’s defaults (see ‘Pay Defaults / Totals tab’ on page 50). If any 
timesheet details have been entered, these are included in the calculations. 

3 Enter or amend the quantities and rates as required. As soon as a quantity or rate is entered, the pay is 
recalculated. If the message Cannot change quantity of Split appears, it means that timesheet entries are 
present for that pay default. 

4 Click the Split Pay button to view, edit, add or delete these entries. 
 Type ‘P’ indicates this a permanent pay split, set up in the Split Default window for the employee. 
 Type ‘D’ indicates a pay split entered through a timesheet. You can create a split for a future date, such as 

pre‐approved leave for a future date, which won’t be included in the current pay. 
 Type ‘T’ indicates a temporary pay split, that is, a pay split for the current pay only. A temporary pay split can 

only be entered in the Enter Pays window. 

Use the other buttons, as described below, for additional functions. A function key can also be used as an 
alternative to clicking a button. All changes are provisional until the pay has been finalised. 
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NOTE :  Enabling function keys    The following function keys are enabled when the cursor is in the Quantity column or certain 
conditions are met. If a function key does not seem to be responding, try re‐positioning the cursor or see the table below for any special 
conditions. 

OK or Esc When the pay is correct, press Esc or click OK to save the changes and return to the employee 
list. The employee will be marked as active, showing that a pay has been prepared for that 
employee. 

 
 
 
 
 
 

F3 ‐ Tax 
Override 

 
 
 
 
 
 

The tax override button is enabled when you select the Rate column for the TAX pay code 
default. Press F3 or click the Tax Override button to display the Pay Frequency/Tax Override 
window. 
The Pay Frequency/Tax Override window enables you to adjust the pay to be taxed over a 
period other than the employees default pay frequency, or by using a different tax code.  
For example, an employee normally paid weekly is being paid for the last week worked plus 
11 days annual leave and 4 days public holiday at Christmas. The pay would be taxed over 4 
weeks instead of the usual 1 week. 
If an employee is being paid an extra lump sum payment, (for example, a bonus), the 
payment needs to be taxed using a secondary tax code (S, SH, or ST). These extra amounts 
can be taxed separately using the Extra Pay Amount field. 

 

 
Leave  Click Leave to view how the annual leave is calculated, the balance of the current leave due 

to the employee prior to the current pay and from here you are able to override the divisor 
to adjust the number of weeks worked by the employee. You can also select the relevant 
daily pay calculation. 

 

 
F5 ‐ 
Message 

Press F5 or click Message to add a message that will print only on this employee's pay slip. If 
you want the message to be printed every pay, select the Keep this message for each pay 
option, otherwise the message will be cleared when the pay is finalised. 
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Super Click Super to view KiwiSaver super contributions and any other employer superannuation 
calculations. This window displays employee and employer contributions, and employer 
superannuation contribution tax (ESCT) calculated for the pay entered. The net contribution 
is the employer contribution less any ESCT. 

F4 ‐ Add 
Default 

Press F4 or click Add Default if a new pay default is required for the employee and the pay 
code has already been created. Select the required pay code. In the window that appears, 
enter the default quantity, if required, and the default rate if allowed. Specify if this new 
default is regular or variable (See ‘Pay Defaults / Totals tab’ on page 50). Click OK.                   
If a new pay default is added by mistake it will need to be deleted from Pay Defaults window. 

Function What it does 

F2 ‐ Leave Press F2 or click Leave to display the Leave Due window, showing the current leave due to 
the employee. This is useful for preparing an employee's final pay (for example, paying out 
the balance of annual leave and leave in lieu), or for checking the amount of leave in advance 
the employee has accrued. Note the figures displayed do not take into account any figures 
entered for the current pay. 



 

 

 
F7 ‐ Print Press F7 or click Print to preview or print a copy of the pay slip for the employee. The Print 

Pay Slip report wizard is displayed. See ‘Print Pay Slips’ on page 84. 
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F8 ‐ Clear 
Pay 

Press F8 or click Clear Pay to clear all details for this pay and return to the employee list. The 
employee will not be marked as active. 

Function What it does 

F6 ‐ Split 
Pay 

This option is only active for earnings pay defaults (gross earnings, taxable allowances and 
non‐taxable allowances). It enables earnings to be allocated to department/cost centres 
other than the employee's (or the pay code's) default. If timesheet details have been entered 
they can be viewed, edited, deleted or added. 
Enter a department/cost centre or press F9 to select from a list. Enter the appropriate 
quantity. Repeat as required. 



 

TO PREPARE A ONE-OFF PAY 

Occasionally, an employee may receive a one‐off pay such as a commission or bonus payment. Rather than zero 
the employee’s defaults manually, MYOB Payroll provides an easy way to clear the pay defaults. 

1 Go to the Prepare Pays command centre and click Enter Pays. The Enter Pays window appears. 

2 Double‐click an employee’s record. The Enter Pays Details window appears. 

3 Click Clear Defaults. The default quantities are zeroed, however any imported or entered timesheet 
information will be retained. 

 

 

4 Proceed to enter details of the one‐off pay. One‐off payments are usually taxed differently. For information on 
using the Tax Override feature to calculate the tax on these amounts, see page 80. 

 
                                                      

    

NOTE :  Editing an employee’s notes    The employee’s notes (Maintain Employees > Qualifications & Notes tab) can be edited by 
clicking the Notes button. 

 
                                                      

    

 
 

PREPARING FINAL PAYS 

When employment ceases, a final pay must be prepared for the employee. This must include any outstanding 
leave. MYOB Payroll does all the hard work for you by automatically calculating final pays. 

If the employee’s finish date is known in advance, it can be entered in the Employment will finish on date field on 
the Employment Details tab in the Maintain Employees window, see page 48. 

 
TO CALCULATE A FINAL PAY 

1 Go to the Prepare Pays command centre and click Enter Pays. The Enter Pays window appears. 

2 Double‐click an employee record. The Enter Pays Details window appears. 
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3 Click Final Pay. The Final Pay Details window appears. 
 

 

4 Enter a finish date and reason. 

5 Click OK. 

Holiday pay is calculated on any outstanding annual leave. An employee is also paid for any public holidays that 
fall in the period of annual leave owed. For example, if the employee is owed two weeks annual leave, and two 
public holidays fall within those two weeks, you need to adjust their final pay accordingly. 

The employee’s pay details have now been updated and it has been tagged as a final pay. 
 

 

6 If you need to adjust the tax rate for the correct number of weeks, click Tax Override. For more information, 
see page 80. 

7 Continue processing the payroll as per usual. The employee’s pay slip will show any outstanding leave as being 
paid out (or deducted if in arrears). 
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TO DELETE ALL ACTIVE PAYS 

Click the Clear all Pay Details button in the Enter Pays window. This will not delete timesheet information or 
default pay settings. 

 
 
 

 

Print Pay Slips 
 

You can print, preview and save (PDF) pay slips for any employee with a current, active pay. You can 
also email pay slips (attached to an email as a PDF file), instead of printing them (See Email Pay Slips, 
page 85). 

 
TO PRINT PAY SLIPS 

1 Go to the Prepare Pays command centre and click Print Pay Slips. The Print Pay Slips window appears. 

2 Select the employees for whom you want to print payslips. If you only want a few, use the Select None option 
and select the applicable employees. 

 

 

3 Click Next. Add a common message on the pay slips, if required. 

4 Click Next. The Email Settings step appears, see To email pay slips, page 85. 

5 Click Next. Choose your printer type. If you are using secure pay slips to be printed using your inkjet or laser 
printer then select the A4‐Secure option. 

6 Click Preview to view on screen or Print to send the report to the printer. 
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Email Pay Slips 
 

Pay slips can be emailed in a PDF format using your current email settings. An Email Pay Slips option is available in 
the Personal Details tab of an employee’s record (Maintenance Command Centre > Maintain Employees). You 
can also specify a reply email address and a message for all recipients. 

Before you can email pay slips from MYOB Payroll, you need to specify your ISP’s SMTP server (see Common SMTP 
servers, page 86) and be connected to the Internet. 

 
TO SETUP AN EMPLOYEE FOR EMAILING PAY SLIPS 

1 Go to the Maintenance command centre and click Maintain Employees. 

2 Select an employee and click the Personal Details tab. 

3 Enter an email address (if there is not one already) and select the Email Pay Slips option. 
 

 
 

TO EMAIL PAY SLIPS 

You email pay slips at the same time as you print them. 

1 Go to the Prepare Pays command centre and click Print Pay Slips. 

2 Complete the required steps. 

3 At the Email Settings step, enter the relevant details. 
 

 

4 Click Next to proceed and continue the steps to print and email pay slips. 

5 When you have finished, a report will be displayed showing which pay slips have emailed successfully and 
which have failed. 
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FIREWALL SETTINGS 

Firewall settings may prevent applications such as MYOB Payroll from sending outgoing emails. If you encounter 
interference from your firewall when emailing pay slips, you may need to modify the rules or exceptions that 
control blocked applications and allow MYOB Payroll. Check the documentation for your operating system for 
details on how to do this. 

 
COMMON SMTP SERVERS 

The following is a list of the main ISP’s and their SMTP servers. 

 Xtra (smtp.xtra.co.nz) 

 ClearNet (smtp.clear.net.nz) 

 Paradise Net (smtp.paradise.net.nz) 

 Actrix Networks (mail.actrix.co.nz) 

 Netlink (mail.netlink.co.nz) 

 EzySurf (smtp.ezysurf.co.nz) 

 IHUG (smtp.ihug.co.nz) 

 Iprolink (smtp.iprolink.co.nz) 

 SouthNet (smtp.southnet.co.nz) 

 World‐Net   (mail.world‐net.co.nz) 

 Orcon (mail.orcon.net.nz) 

 Globe Net Communications (smtp.globe.net.nz) 

 Dream Net Internet (mail.dreamnet.co.nz) 

 I4U Internet Services (mail.i4u.net.nz) 

 Slingshot (smtp.slingshot.co.nz) 

 Data Solutions (smtp.datasolutions.net.nz) 

 DSNet Internet Services (smtp.dsnet.co.nz) 
 

                                                      
    

NOTE :  Outlook users    Microsoft Outlook lists your SMTP server under Tools menu > Email Accounts > View or Change email 
accounts. 
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4 Processing pays 
This chapter explains how you print a pay summary, payment schedules, back up your data 
and update the PAYE period in MYOB Payroll. 

It also explains how to finalise a pay run. When you finalise a pay run, the pays entered in the 
Prepare Pays command centre are recorded in your system. This includes updating 
year‐to‐date balances and employee details. To ensure your records are calculations are 
accurate, you must enter all pay details before you finalise a pay. 

 
 
 

 

Overview 
 

The Process Pays command centre is used after a pay run has been prepared and checked. In 
any MYOB Payroll command centre, click Process Pays. The Process Pays command centre 
appears. 

 

 
You can do the following tasks. 

 

 
Print payment summaries page 88 

 

 
Backup your data page 90 
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Print payment schedules page 89 

To do this… See… 



 

 

 
Update the PAYE period page 92 

 
 

 

WHICH REPORTS SHOULD I PRINT? 

The pay summary and the payment schedules are the recommended minimum reports to print and file each pay. 
Optional reports include: 

 Cost Analysis reports for accounting or cross‐checking purposes 

 Deductions report 

 Non‐Taxable Allowances report 

 Employer Superannuation report. 

These reports can only be printed before a pay is finalised. For more information on reports see ‘Payroll reports’ 
on page 93. 

 
 
 

 

Print the pay summary report 
 

By law, the Pay Summary report must be retained for each pay run. This report lists the details and totals of each 
employee's pay slip, with totals for the pay run. 

 

 
 

TO PRINT A PAY SUMMARY 

1 Go to the Process Pays command centre and click Print Pay Summary. 

2 Select the Print Timesheet details for each Pay Code option if: 
 Timesheet details have not been imported or entered 
 Pay has been split between departments 
 Timesheet Details report has not been printed. 

3 Click Preview to view on screen or Print to send the report to the printer. 

4 Check the report for any errors. 
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To do this… See… 

Finalise the pay page 90 



 

 If errors are found, return to the Prepare Pays command centre and make the necessary corrections. Reprint the 
affected pay slips and the pay summary. 

 If no errors then print and file. 

A pay summary report must be printed before the pay can be finalised. it is recommended that the final pay 
summaries are filed in sequential order in a payroll file. 

If there are numerous timesheet entries or split pays, we recommend you print a Timesheet Details report from 
the Prepare Pays command centre, see ‘Print timesheets’ on page 77. 

 
 
 

 

Print payment schedules 
 

This report prints a schedule of cash pays together with a cash breakdown for the bank (if any employees are 
receiving cash for the current pay). 

 

 

A schedule of cheques to write and a schedule of direct credits are also printed. 

Most banks require the direct credit information to be transferred onto the schedules they provide, if the direct 
credits are not electronically sent to the bank. 

 
TO PRINT PAYMENT SCHEDULES 

1 Go to the Process Pays command centre and click Print Payment Schedules. 

2 Click Preview to view on screen or Print to send the report to the printer. 
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Backup 
 

Back up the payroll data before finalising so that if you find errors in the pay, or your data becomes corrupted, you 
have a restorable backup. 

It is recommended that you regularly save a backup to an external drive (such as a USB drive) or a CD. 
 

TO BACKUP YOUR PAYROLL DATA 

1 Go to the Process Pays command centre and click Backup. The Backup Up Payroll Data window appears. 
 

 
 

                                                    
   

NOTE :  Multiple backups to the same disk or folder     Each backup created has a unique name, which means multiple backups can 
be made to the same location. The filename format is ‘MYOBPayroll’ followed by the payroll name then the date and time (e.g. 
MYOBPayrollBackup‐Clearwater‐20130216164314.zip). 

 
                                                    

   

 
2 Click the ellipsis button to open Windows Explorer and choose where you are going to save the backup. If you 

are backing up to another drive on your network, navigate to the network folder. If you are backing up to an 
external drive, navigate to the drive. Click OK when you are ready to proceed. 

3 When successful, a message appears confirming your data has been backed up. 

For a full explanation on the backup procedure see ‘Backing up and restoring your data’ on page 106. 
 
 
 

 

Finalise the pays 
 

When you finalise a pay, the pay details entered in the Prepare Pays command centre are recorded in your system. 
This includes updating year‐to‐date balances and employee details. It also includes clearing the details of the 
current pay. 

You must finalise pays to record the pay details in your system and to prepare your payroll for the next pay run. 
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To ensure your records are calculations are accurate, you need to enter all pay details before you finalise a pay. You 
can edit or clear a pay before it is finalised. However, once finalised, it can only be reversed by restoring from an 
earlier backup, see ‘Backing up and restoring your data’ on page 106. 

 

 
 

PAY PERIODS 

Ensure the current PAYE period, the current pay ended date and number of active pays (employees being paid) are 
all correct. If these are not correct, click Cancel and make any needed changes (see ‘Change the PAYE period’ on 
page 92). The correct PAYE period is the one in which the wages are actually paid and may be different from the 
one in which the pay ends. 

 
                                                    

      

NOTE :  Bank holidays    To deal with bank holidays, e.g. the Christmas and New Year period, you can send the files to the bank early. Set 
the paid on date to be the week that the pay is for. 

 
                                                    

      

 

DIRECT CREDIT FILES 

If the payroll has been set up with a path for the direct credit files and a bank account number, the direct credit 
files are created when you finalise the pay. The default direct credit details are displayed on the Finalise Pay 
window but can be changed if required. See ‘Direct Credit Path’ on page 24. 

 
                                                    

      

NOTE :  Consult your bank and F1 online help for specific information    There may be specific details required in these fields for your 
particular bank setup. Additional information can be obtained by pressing F1 or contacting your bank. 

 
                                                    

      

 

TO FINALISE THE PAY 

Click OK in the Finalise Pay window. This will create the direct credit files, update employee records and clear the 
current pay. To cancel the finalising process, click Cancel. 

 
INTEGRATION TO YOUR ACCOUNTING SOFTWARE 

When you have finalised your pay, payroll journals are created if you are posting manually to your accounting 
software, or are posted automatically into your MYOB AccountRight software, if you have selected to do that. 

You may be prompted to Include Costcentres as Job Codes in Journal entries. Select this option if required. 

See ‘Accounting System’ on page 23 for more information. 
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Change the PAYE period 
 

You use Change PAYE Period feature to manually update the current PAYE period to the next (or previous) PAYE 
period. 

This is usually used after the last pay for the month (or half month if a large employer, see ‘General details’ on 
page 22). If this step is missed, when the next pay date is entered you will be automatically prompted to update 
the PAYE period. 

 

 
 

TO UPDATE THE PAYE PERIOD 

Click OK to proceed with the update. If the new period is the next month, you will be prompted to print the 
employer monthly schedule. After this report is printed you will be prompted to print the IRD remittance advice. 

 
TO REVERSE THE PAYE PERIOD 

Select Reverse PAYE Period to return to a previous period. 
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5 Reporting 
This chapter explains how to generate reports to monitor your payroll, satisfy legal 
compliance and meet IRD requirements. 

It also explains how you can export pay history to be analysed in other software applications, 
such as a spreadsheet. 

 
 
 

 

Payroll reports 
 

MYOB Payroll uses wizards to help you prepare reports. To produce reports, you simply work 
your way through the wizard and click Preview or Print to view the finished report. See 
‘Printing options’ on page 94 and ‘Printer properties’ on page 95. 

 
TO SELECT A REPORT 

You can access reports via: 

 The Reports menu—this gives a full list of reports which are employee balance‐related, 
and those printed after finalising pays. 

 The Payroll menu—this gives a full list of reports which directly relate to the current pay 
in progress. 

 
COMMAND CENTRE REPORTS 

In previous chapters, we have shown you how to access the following reports related to 
preparing and processing payroll. See: 

 ‘To print timesheets’ on page 77 

 ‘To print pay slips’ on page 84 

 ‘To print a pay summary’ on page 88 

 ‘To print payment schedules’ on page 89. 
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Printing options 
 

MYOB Payroll allows you to print and preview a wide variety of payroll information. Some of the following options 
may not be available on all print screens. Apart from the Print button, these options will first generate a preview 
on screen. Click Print on the preview to send the report to your printer. 

 
File menu Select Print from the File menu. This option will only be available when the screen 
that has focus is able to be printed. 

 
Keyboard shortcut    Press Ctrl+P to print the currently selected screen. 

 
   Print button    On the report options screen, click this button to send the report to your printer. 

   Preview button   Available from the report options screen, this button firsts displays the report on the 
screen. From the preview window send it to the printer by clicking the Print button. 

 
      PDF button You can save some reports as a PDF. When saving, set a path and name for the file and 

then click the PDF button. 
 

EMPLOYEE FILTER 

Many of the available reports allow you to choose which employees you wish to include in the report. 

The employee are listed alphabetically and can be selected for inclusion individually, by clicking the select 
checkbox next to a name. Alternatively, use the Select All or Select None buttons. 

 

 
If you only wanted to select one employee then click the Select None button and then click on the employee you 
want to report on. 

Click Finish or Next to proceed to the next step of the report wizard. 
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PRINTER PROPERTIES 

When you click the Print, or select Page Setup from the File menu, a Windows Printer dialog box appears. You can 
choose a different printer or set printer properties from here. 

 

 

Select the printer you want to use from the drop‐down list. Click Properties to change printer settings such as 
print quality and colour options. 

 
 
 

 

Available reports 
 

To make the best use of the available reports in MYOB Payroll, it is helpful to know which reports to print and 
when. The table below describes several payroll reports. For more detailed information, refer to ‘Additional report 
information’ on page 97. 

 

 
IRD Remittance 
Advice 

End of each PAYE 
Period 

This report contains all the required information to fill out the IR345/346 
forms (PAYE payments). 

 

 
Pay Audit Trail  End of year 

(recommended) 
Lists each pay that has been finalised, grouped by PAYE period, showing 
totals for each type of pay code. 

 

 
Holiday Accruals End of year 

(recommended) 
Prints the current annual leave and holiday pay balances for each 
employee. 
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Pay Code Totals End of year 
(recommended) 

Summarises the year to date figures for each pay code. 

Employer Monthly End of each month 
Schedule (IR 348) 

This contains all the start/finish, child support, student loan and the 
earnings details of all employees for the chosen month. 

Report When to print Description 



 

 

Report When to print Description 

Apprentice Hours When required Prints details of those hours worked as apprentice hours by your 
employees. 

Employee Statistics When requested by 
Statistics NZ 

Details the gender and employment status of each employee. 

Department List When required A simple report showing the department/costcentre setup, including 
the GL integration code. 

Current Employees When required Shows each employee's (except those with a finish date) start date, tax 
code and their current pay rates. 

Maintenance Audit When required All changes made to employees, pay codes and department/costcentre 
including when a pay is finalised, when holiday anniversary updates 
occur and when the payroll is backed up or restored. 

Period Reports When required Analyse your pay history, according to a variety of different criteria. 
Additional option to export as a spreadsheet file, see page 102. 

Employee 
Addresses 

When required List of all employees and their current addresses, phone and fax 
numbers, allocated department/costcentre and start date. 

Employee Balances When required List of employees and their current payroll balances. 

Employee Audits End of year 
(optional) 

Full pay history for each employee. 

Employee Holidays End of year 
(optional) 

Summary of the employee’s leave details to date. 

Employee Sick 
Leave 

End of year 
(optional) 

Summary report of the employee’s sick leave details. 

Employee Leave in 
Lieu 

End of year 
(optional) 

Summary of employee’s leave‐in‐lieu information. 

IRD Schedule End of year Two copies printed; one filed and one attached to the IR68A. 

Earnings 
Certificate 

End of year or when 
employee finishes 

These replaced the IR12 certificates in March 1999. 

PAYE Subsidy Claim When required Only available to registered payroll intermediaries (email 
sales@myob.co.nz for more information) 
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Additional report information 
 

The following reports can be previewed to screen or sent to the printer of your choice. See ‘Printing options’ on 
page 94 and ‘Printer properties’ on page 95. 

 
                                                    

      

NOTE :  Current pay details    Until a pay is finalised, the current pay details are not reported on. 
 

                                                    
      

 

IRD REMITTANCE ADVICE 

This report contains all the required information to fill out the IR345/346 forms. Simply transfer the information 
across to the official form and include with your PAYE payment (20th of month for small employers, 5th & 20th of 
month for large employers). 

 
                                                    

      

TIP :  Create all IRD reports and files easily    Select the Create IRD reports option in the Reports menu to print the IRD Remittance 
Advice, Employer Monthly Schedule, and to create the direct credit file and files for ir‐Filing. 

 
                                                    

      

 

EMPLOYER MONTHLY SCHEDULE (EMS) (IR 348) 

This contains all the start/finish, Child Support, Student Loan And the earnings details of all employees for the 
chosen month. This prints automatically when a PAYE period is updated to a new month but is also available from 
the Reports Menu. 

The IRD will not accept a summary format EMS. The details must either be: 

 transferred electronically to the IRD by sending the csv file, which is optionally created when this report is 
printed 

 manually input into the ir‐File website and transferred electronically to the IRD 

 printed in the IRD Approved Format and posted to the IRD (mark the checkbox after selecting the Employer 
Monthly Schedule). 

See the IRD booklet on ir‐File (IR343) for more information. The created csv files are stored in your ir‐File folder, 
specified in Options, see ‘Accounting integration details’ on page 23. 

 
SENDING KIWISAVER DETAILS TO THE IRD 

A KED (KiwiSaver Employee Details) file is created when the Employer Monthly Schedule (EMS) is produced and 
can be ir‐Filed electronically to the IRD along with the EMS. This file includes the required KiwiSaver employee 
information, as well as details of those who opt‐out. 
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Also created is a zip file containing all the relevant EMS, KED and EDF files for ir‐filing. This is particularly useful if 
you run multiple payrolls. 

 
PAY AUDIT TRAIL 

The Payroll Audit Trail report lists each pay that has been finalised, grouped by PAYE period, showing totals for 
each type of pay code. the details listed for each pay are the same as the total line from the pay summary. Use this 
report to check that all pays have been finalised and that the overall totals are correct. 

 
PAY CODE TOTALS 

The Pay Code Totals report summarises the year to date figures for each pay code. Each pay code's default rate, the 
amounts for the last pay and the month to date and year to date amounts are displayed. The pay codes are 
grouped by pay code type. In other words, all gross earnings pay codes are printed first and are totalled, then 
taxable allowances, etc. 

There is an option to print each pay code type on a separate page. 
 

HOLIDAY ACCRUALS 

The Holiday Accruals report prints the current annual leave and holiday pay balances for each employee. We 
recommend this report is printed at the end of each month, with a copy provided to your accountant at the end of 
the financial year. It shows the total liability for annual leave and holiday pay. 

 
APPRENTICE HOURS 

This report prints details of those hours worked as apprentice hours by your employees. Information from this 
report is taken from the apprentice hours accumulator, see ‘Maintaining Accumulators’ on page 70. 

 
EMPLOYEE STATISTICS 

Usually, you would print this report when the details are requested by Statistics NZ. The report details the gender 
and employment status of each employee (such as full‐time, part‐time etc.). You can select to have the employee's 
names showing on the report if you want. 

 
DEPARTMENT LIST 

Displays the department and costcentre setup, including any general ledger code integration details. 
 

CURRENT EMPLOYEES 

The Current Employees report prints all employees that are set up. It excludes any employees with a finish date. 
The report shows each employee's start date, tax code, and their current pay rates. 

 
MAINTENANCE AUDIT 

The Maintenance Audit report is a useful tool in finding information about your payroll’s history. All changes made 
to employees, pay codes and department/cost centres are captured as well as information when a pay is finalised, 
when holiday anniversary updates occur, changes to leave details and when the payroll is backed up or restored. 

The information captured includes what record was changed, by whom and when, as well as the old value and the 
new value. 
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PERIOD REPORTS 

Period reports let you analyse your pay history for specified periods, according to a variety of different criteria, 
including the following: 

 Employee Superannuation 

 Employee/Pay Code (Summary Report) 

 Department/Costcentre/Employee 

 Department/Costcentre/Pay   Code 

 Department/Costcentre/Month. 

In the report wizard that appears when you prepare these reports, you can choose which pay history periods you 
want to include. For example: 

 

 
 

Export Pay History To export a pay period as a CSV (comma delimited) file, go to the Reports menu > Period 
Reports > Export Pay History. After making your filter selections and choosing a destination for the CSV file, click 
Export. See ‘Exporting pay history information’ on page 102. 

 
EMPLOYEE ADDRESSES 

Use this report to print a list of all employees and their current addresses, phone and fax numbers, allocated 
department/ costcentre and start date. 

 
EMPLOYEE BALANCES 

This will print off a list of employees and their current balances in the payroll system. You can choose to print or 
preview the full list (includes a breakdown of their individual pay codes), or a summary (one employee per line 
report). 
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EMPLOYEE AUDITS 

The Employee Audit Report prints the full pay history for each employee. You can select how many employees you 
want to include in the report. The report prints each employee in turn, with a breakdown of the PAYE periods and 
amounts finalised to date. This report can be very long if all employees are selected. 

 
EMPLOYEE HOLIDAYS 

This report prints a summary of the employee holidays to date. It prints one employee per page, and reflects the 
annual leave and holiday information contained in Maintain Employees, Leave Details tab, with a breakdown of 
the leave taken and any manual changes made. 

 
EMPLOYEE SICK LEAVE 

The Sick Leave report prints a summary report of the employee sick leave entitlement and the sick leave taken. 
This report also prints one employee per page, and reflects the information contained in Maintain Employees, 
Leave Details ‐ Other tab, with a breakdown of the sick leave taken and any manual changes made. 

 
EMPLOYEE LEAVE IN LIEU 

This report prints employee Leave in Lieu information. This report also prints one employee per page, and reflects 
the information contained in Maintain Employees, Leave Details ‐ Other tab, with a breakdown of the leave in lieu 
taken or accrued and any changes made manually. 

 
PARENTAL LEAVE DETAILS 

This report prints parental leave details for each selected employee, including start date, (actual) end date, 
expected end date, IRD number, normal days per week, ordinary weekly earnings and length employment. 

 
EMPLOYER SUPERANNUATION 

Reports on all pay Superannuation pay codes, i.e. pay codes which have been set up as employee superannuation 
contribution codes. (See ‘Super tab’ on page 39) This will covers all super schemes, including approved and 
non‐approved KiwiSaver schemes. This includes employer and employee contributions, SSCWT, Employer Net 
amount, Total Contribution less tax, Employer Tax Credit, and Net Employer Contribution. 

 
EMPLOYEE BIRTHDAYS 

This report lists all employees with birthdays falling within a specified month. See ‘Personal Details tab’ on 
page 47. 

 
ACCUMULATOR BALANCES 

Displays the current balance of employee’s accumulators. See ‘KiwiSaver Eligibility flowchart’ on page 58. 
 

REMINDERS 

Displays active reminders for a given date range. See ‘Reminders tab’ on page 60. 
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STAFF TURNOVER REPORT 

Display totals of new staff starting and current staff finishing. It includes occupation and reason‐for‐leaving details. 
A summary option is available, which only displays totals. 

 
IRD SCHEDULE 

The IRD Schedule is printed at the end of the year (March). See ‘End of Year Processing’ on page 99. 
 

EARNINGS CERTIFICATE 

The Earnings Certificates are printed at the end of the year or when an employee finishes. These replaced the IR12 
certificates in March 1999. 

 
 

REPORTS FOR PRIOR YEARS 

The Employer Monthly Schedule, IRD Remittance Advice, IRD Schedule, Pay Audit Trail and Earnings Certificates 
reports can all be printed for prior tax years. 

 

 

The default is the current tax year. 
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Exporting pay history information 
 

For greater flexibility and analysis options, you can export pay history information to a comma‐delimited file, 
which can be opened in most spreadsheet programs. For information on entering pay history, see Entering pay 
history, page 110. 

 
TO EXPORT PAY HISTORY 

1 Go to the Reports menu, point at Period Reports and choose Export Pay History. The Export Pay History 
wizard appears. 

2 Adjust the filter settings (if required). Continue clicking Next until the last step appears. 
 

 

3 If you want to change the destination for the spreadsheet file, click the ellipsis button [...] and browse for a 
new folder. 

4 Click Export. If Microsoft Excel is installed on your computer, it will automatically start and open the export file 
you have just created. If not, start your spreadsheet software and open the export file. 
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6 Other functions 
This chapter includes information about end‐of‐year processing, protecting and maintaining 
your data and editing your file preferences. 

 
 
 

 

End of year processing 
 

There are some functions that need to be performed at the end of each tax year, including a 
number of reports you will want to print. Make sure you have upgraded to the latest version 
of MYOB Payroll to ensure you have the correct tax rates. 

 
                                               

NOTE :  Reversing PAYE periods at end of financial year    Note that you if you reverse your PAYE period at 
the end of the financial year, the KiwiSaver rates will not be reversed. If you process a pay run in this prior 
PAYE period, the KiwiSaver rates will not be correct. 

 
                                               

 
Complete the usual end of month tasks when you are transitioning from the last month of 
the year to the new tax year, such as the CSV file for IR‐filing, Employer Monthly Schedule, 
create journals for posting to your accounting software. 

 
BEFORE PROCESSING PAYS IN THE NEW YEAR 

The following checklist outlines the typical tasks you might perform before entering pays in 
the new payroll year. The reports listed here can be run for any tax year, so you can run them 
at any time. If you want to implement new departments or pay codes from the start of the 
tax year, then it makes sense to update these before the first pay of the new tax year. 

 

 
Upgrade your software You should upgrade your MYOB Payroll software before 

processing pays in the new year. This is to ensure you have the 
latest tax rates. 
If you process pays in the new year without upgrading, you risk 
taxing your employees at incorrect rates. For more information, 
contact sales@myob.co.nz 
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Enter employee finish dates Enter finish dates for employees that are no longer employed 
with you. All annual leave and holiday pay will need to be set to 
zero before you can enter the finish date. 

Task Description 

mailto:sales@myob.co.nz


 

 

 
Print these YTD reports •   Employee balances 

• Pay Audit Trail 
• Pay Code Totals 
• Holiday Accruals (prints totals as they are now, so should be 

printed at least monthly) 
• Earnings Certificates: These are not required by the IRD, but 

we recommend that they be printed so that employees can 
check the information provided by the IRD. They are designed 
for printing on letterhead paper. 

• IRD schedule: print this for your records. 
• Note: If you have entered all or part of your Pay History 

manually through Enter History, this data will not be included 
in the Gross Earnings/PAYE details of the Earning Certificate. 

 

 
Add any new departments Add any new departments, and then change the default 

departments of employees and pay codes if necessary. Delete, or 
make inactive, any departments you no longer require. 

 

 
 

 
 

Creating accounting journals 
 

The Create Journals feature is available if accounting software integration has been setup (see ‘Accounting 
integration details’ on page 23) and the departments and cost centres have been allocated a GL account code 
(account number), see page 33. 

Although you can assign a specific deduction pay code to departments, (Maintain Pay Codes, see page 36), if no 
code is specified, a default liability account code (entered in the Options window) is used. 

Journals are usually required when the wages are posted to several different general ledger codes and multiple 
department and cost centres have been set up. 

Use the Create Journals feature when you manually want to post your payroll journals to your accounting 
software. If you integrate with MYOB accounting software, and you have selected the Automatically post journals 
into the company file option, you don’t need to manually post journals (see ‘Task 3: Set up posting options’ on 
page 29). 
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Add any new pay codes Add any new pay codes if required, and delete or make inactive 
any pay codes you no longer require. 

Optional YTD reports. The following reports will all print one page per employee. 
• Employee Audits 
• Employee Details 
• Employee Holidays 
• Employee Special Leave 
• Employee Leave in Lieu 

Task Description 



 

HOW JOURNALS ARE CREATED 

 A journal is automatically created each time a pay is finalised. The journal contains the accounting details for 
that pay. The journal is overwritten the next time a pay is finalised. 

 A journal can be manually created using the Create Journals feature on the Tools menu. This feature allows 
you to create journals for any past pays, within the current tax year. See ‘To manually create a journal’ below. 

 
TO MANUALLY CREATE A JOURNAL 

1 Go to the Tools menu and choose Create Journals. The Create Journals window appears. 

2 Choose what pays you want to include in the journal and then decide whether to create a separate journal for 
each pay, a separate journal for each month or one journal for all the pays selected. 

 

 

 If you select the Create one journal entry for each pay option, the date of each journal will be the last day of 
the PAYE period in which the pay was finalised i.e. the 15th of the month or the last day of the month. 

 If you select the Create one journal entry for each month option, the date of each journal will be the last day 
of the month. 

 If you select the Create one journal entry for all selected pays option, the date of the journal will be the last 
day of the tax year. This option is usually only used by accountants preparing the annual accounts. 

 
TO IMPORT JOURNALS INTO MYOB ACCOUNTANTS OFFICE 

1 Open the ledger that the payroll is integrating with (see ‘Accounting integration details’ on page 23). Ensure 
the period covered by the ledger matches with the date of the journals created in MYOB Payroll. 

 
                                                  

     

NOTE :  Importing into other accounting software packages    See F1 online help for information on importing into other software. 
 

                                                  
     

 
2 Go to the File menu, choose Import and then choose MYOB Payroll Transactions. Any journals created will be 

posted to the accounts specified in the integration details or the department setup. 
 

Related Procedures 

 Setting up accounting integration, see ‘Accounting integration details’ on page 23. 
 Adding GL codes to a department and costcentre, see ‘Maintaining departments and costcentres’ on page 32. 
 Adding GL codes to deduction pay codes, see page 40. 
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TO MANUALLY IMPORT JOURNALS INTO ACCOUNTRIGHT V19 

1 In your AccountRight software, go to the File menu, choose Import Data and then choose Transaction 
Journals. 

2 In the Import File Format field, select Comma‐separated. 

3 In the First Record is field select Data Record. 

4 Click Continue. 

5 Browse to the Payroll.txt file, which will be located in the folder specified in the Payroll Options > Accounting 
window. 

6 Click Open. 

7 Select Match All and click Import. The imported journal can be found in AccountRight as a general journal. 
 

TO MANUALLY IMPORT JOURNALS INTO ACCOUNTRIGHT V2013 AND LATER 

1 In your AccountRight software, go to the File menu and choose Import/Export Assistant. 

2 Click Import data and click Next. 

3 In the Import field, select Transaction Journals. 

4 Click Browse and locate the Payroll.txt file you exported from MYOB Payroll. Click Next. 

5 Select the Commas and Data options. Click Next. 

6 Match the fields, or click Auto Match to match the fields that have the same names. Click Next. 

7 If you want to make a backup of your AccountRight company file, click Back up, otherwise click Import. 

8 Click Close. The imported journal can be found in your AccountRight company file as a general journal. 
 
 
 

 

Backing up and restoring your data 
 

To protect your business information and ensure you have a copy of everything if you need it, you should back up 
your MYOB Payroll data regularly. We recommend you make multiple backups and store copies off‐site. 

MYOB Payroll enables you to create a compressed backup version of your payroll file (known as a .zip file) which can 
be copied to a network location or an external storage device such as a DVD or memory stick. We also recommend 
that you perform repairs on your file before you back up. This may fix errors in the file you may not be aware of. See, 
‘Repairing the payroll file’ on page 108. 

 
How often should I back up? It’s up to you how often you backup your data. However, should your current file 
become corrupt, and you have to restore your latest backup, you will need to enter everything since that backup 
was made. 

In addition to regular backups as you use MYOB Payroll, you might also want to make monthly, quarterly and 
annual backups. These can also serve as archives for each period, should you need to access data or run a report 
again. 
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TO BACK UP YOUR PAYROLL FILE 

1 Go to the File menu and choose Backup. The Backing Up Payroll Data window appears. 
 

 
 

2 Click on the ellipsis button [...] to choose where you want to save your payroll data. 
 

                                                  
     

NOTE :  Backup filename    Each backup created has a unique name. The filename format is ‘MYOBPayroll’, followed by the  
company file name, then the date and time (e.g. MYOBPayrollBackup‐ Company Name ‐ 20110216164314.zip). This means you can 
make multiple backups to the same location, such as a network, and know which file is the latest. 

 
                                                  

     

 
3 Click OK. 

4 If your backup has been successful the Backup Data window is displayed. 

5 Click OK. 
 

TO RESTORE A BACKUP 

You can easily restore a backup copy of your MYOB Payroll file. Note that restoring a backup replaces the current 
payroll file you have open. If you want to retain this version, you need to make a backup of this file before 
restoring. 

1 Go to the File menu and choose Restore. The Restore Payroll Data window appears. 
 

 

2 Locate your backup file by clicking the ellipsis button (...) to browse for the location. 

3 Click OK. The window appears asking you to confirm that you want to restore the file. 
 

 

4 Click OK to confirm. 

5 Click OK when the restore is complete. 
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Repairing the payroll file 
 

If you are working on your file and there is a power outage, or your computer suffers damage while your payroll 
file is in use, your payroll file may become damaged. Repairing your file by rebuilding the index and rebuilding the 
payroll list can help. 

 
TO REBUILD THE INDEX FILES 

Index files are used to find or link records in the various databases of the program. In some circumstances, such as 
a power failure during data entry, index files may become corrupted and need to be rebuilt. If your software 
displays errors while trying to read payroll files or if transactions which are known to exist cannot be found, then 
use this option to rebuild the indexes. 

 Go to the Tools menu and Reindex Data Files. The index is rebuilt. 
 

TO REBUILD THE PAYROLL LIST 

Select this option if you have copied a payroll to your program folder by using Windows Explorer. That way, MYOB 
Payroll can recognise the payroll file as belonging to its program. 

 Go to the Tools menu and select Rebuild Payroll List. You have successfully rebuilt your payroll file list. 
 
 
 

 

Managing passwords 
 

You can use MYOB Payroll without setting a password. However, it is recommended that a password be used if 
there is the possibility the payroll file may be accessed by other persons. 

If you need to ensure that only an authorised person should have access to your data, you can specify a password 
that must be entered before MYOB Payroll can open your payroll file. 

 
TO CREATE THE PASSWORD 

You can create a password of up to ten alphanumeric characters. Passwords are not case‐sensitive. 

1    Go to the Tools menu and choose Change Password. The Change Password window appears. 
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2 Enter the password you wish to use in the New Password field. 

3 Re‐enter the same password in the Repeat New Password field and click OK. The following message is 
displayed. 

 

 

Your payroll file is now password protected. The next time you open this payroll file you will need to enter the 
password in the Open window. 

 

 
 

TO CHANGE THE PASSWORD 

You can change your password at any time. You can use up to up to ten characters. 

1 Go to the Setup menu and choose Change Password. The Change Password window is displayed. 
 

 

2 Enter the current password in the Current Password field. 

3 Enter the new password you want to use in the New Password field. 

4 Re‐enter the new password again in the Repeat New Password field. 

5 Click OK. A confirmation message appears. 

6 Click OK. Your password has been changed. 

The next time try to open this payroll file you will need to enter your new password in the Open window. 
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TO DELETE THE PASSWORD 

1 Go to the Setup menu and choose Change Password. The Change Password window is displayed. 

2 Enter the current password in the Current Password field. 

3 Leave the New Password and Repeat New Password fields blank. 

4 Click OK to remove the correct password. 

5 When prompted, confirm the password change. The password has been removed. 
 
 
 

 

Entering pay history 
 

MYOB Payroll can use historical pay information to correctly calculate the annual leave pay rate. 

If converting from an existing system, historical pay information is entered using the Enter History option 
(available from the Tools menu). Pay history needs to be entered for each employee and for each separate pay 
they have received in the prior 12 months. It should not be entered as a lump sum amount. This information is 
only used for the calculation of annual leave and does not appear on PAYE reports. 

 

 

To make it easier to setup existing staff when converting from another payroll system, an option to import pay 
history or create pay history by replicating an entered pay (up to 24 months) is now included. 

You can also import pay history from a spreadsheet that has the following format. 
 

 

A spreadsheet template has been provided with your software CD. 
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TO IMPORT PAY HISTORY FROM A SPREADSHEET 

1 Make sure the employee has been added to MYOB Payroll and the employee code is correct. 

2 Go to the Tools menu and choose Enter History. The Enter History window appears. 
 

 

3 Click Import. The Import History window appears. 

4 Click the ellipsis button to locate the Excel spreadsheet file you want to import. 

5 Select the file and click Import. 

If any errors are encountered, a message will appear giving you the option of viewing the error details. You 
might need to check that the format used in the spreadsheet is correct and import the file again. 

 
TO REPLICATE AN ENTERED PAY 

Replicating a pay is an easy way to enter history for multiple pay periods for the same amount. 

1 Go to the Tools menu and choose Enter History. The Enter History window appears. 

2 Enter a pay manually, select it then click Replicate. The Replicate History window appears. 
 

 

3 Enter the date range you want to repeat this pay for. The pay frequency is based on the employee’s settings 
(Employment Details tab). 

4 Click OK. The selected pay will be repeated for the dates entered, where pays are missing. 
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Purge old data 
 

If you want to reduce the size of the file you currently work in, you can purge data that you no longer need. 

This option allows you to optimise your data file by deleting old records that are no longer used, such as 
ex‐employees, inactive pay codes and departments, maintenance records and completed reminders. The process 
is irreversible, so you need to make a backup of your file before you purge. 

 
TO PURGE OLD DATA 

1 Go to the Tools menu and select Purge Old Data. The Purge Old Data window appears. 
 

 

2 Set the tax year and click OK. Data up to, and including, the selected year will be purged. Data cannot be 
purged for the current tax year and two years prior. 

3 You will be asked to confirm the data purge. Click Yes to confirm. 
 
 
 

 

Consolidate payrolls 
 

The ability to consolidate payrolls allows you to combine data from two or more current payrolls into one single 
payroll. 

Consolidated payrolls can be used in the following situations: 

 Combining divisions of one company that are in separate payrolls (usually for IR‐Filing). 

 When two businesses merge together into one company, to bring all employees into the one payroll. 

 Change of ownership. 

Information on setting up and using consolidated payrolls is outlined in more detail in MYOB Payroll help. 
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PAYE calculator 
 

Select PAYE Calculator from the Tools menu. The PAYE Calculator window appears. 
 

 

Select the appropriate tax code from the drop‐down list, enter the period covered and the taxable earnings. The 
PAYE will be calculated automatically. 

You can calculate PAYE for previous years as well by changing the year ended date. The list of tax codes will be 
updated accordingly. 

Note that when back‐calculating PAYE for previous years, the KiwiSaver rates will not be reset. 
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Glossary 
 
 
 
 
 

 

A 
 

account code    The account code is what 
identifies an account. In MYOB Payroll, you 
can set up integration with a GL account 
code. An example of an account code is 
‘908/05’, which is a subcode of master 
account ‘908’. 

There are master accounts and subcodes; the 
master account is used to group accounts 
(subcodes) together. 

 
ACC    The Accident Compensation 
Corporation (ACC) administers New 
Zealand's accident compensation scheme, 
which provides accident insurance for all 
New Zealand citizens, residents and 
temporary visitors to New Zealand. In return, 
people do not have the right to sue for 
personal injury, other than for exemplary 
damages; www.acc.govt.nz 

 
annual leave An entitlement to at least 
three weeks paid leave after working 
continuously for the same employer for 12 
months. 

 
audit trail    A list of the changes that have 
occurred in MYOB Payroll. 

 
 

 

B 
 

back pay    A payment given to a person 
when they receive a back‐dated pay increase. 

Bank Account The number identifying the 
bank, branch, customer number and account 
number that payments are made to or from. 

 
Bank File A file containing Direct Credit 
transactions that is transmitted to your bank 
to pay your people, deductions, 
superannuation and processing fees. 

 
Bank Schedule A report produced with 
every payroll that lists all payments made 
from the organisation's bank account. 

 
Banking Date    The date that the payroll 
funds are taken out of the company's bank 
account to pay staff. This is one (working) day 
before pay day. 

 
balance    The sum of all the money added to 
and subtracted from an account. 

 
 

 

C 
 

Casual    A person who receives Casual 
Holiday Pay payments each pay, as opposed 
to a Permanent employee who accrues an 
annual leave entitlement. 

 
consolidate    Combine two or more payroll 
files 

 
compulsory shutdown    A specific period 
where the firm closes, e.g. Christmas/New 
Year. In these cases, a common anniversary 
for updating leave entitlements would be 
used. 
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Costcentre    Payroll transactions may be 
charged against cost centres to provide 
various costing reports to help you manage 
and analyse payroll costs. 

 
CSD Child support is money paid by parents 
who are not living with their children, to help 
financially support their children. The scheme 
is administered by Inland Revenue. 

 
 
 

D 
 

data file    This is the file (or, more correctly, 
the set of files) that stores all the information 
about the different companies and the 
transactions your enter for them. 

 
Direct Credit    An entry in a Bank File. 

 
double‐entry accounting    A method of 
bookkeeping in which every entry is balanced 
by another entry. Correct double‐entry 
accounting always provides a balanced set of 
books; that is, the total value of your asset 
accounts will equal the total value of your 
liability and equity accounts. Your 
accountant’s MYOB Accountants Office 
software uses double‐entry bookkeeping. 

 
 

G 

general ledger    This is where your 
accountant brings all your account 
information together—sales, purchases, cash 
in, cash out. Your accountant generates your 
financial statements—balance sheet and 
profit and loss (income) statement—from the 
general ledger. 

 
Gross Pay    The total dollar value of all 
payments, including leave, made to a person 
or included in a payroll. This excludes 
processing fees and superannuation subsidies. 

 
GST    Goods and services tax (GST) is a tax on 
the supply of most goods and services in New 
Zealand. It is generally charged at a rate of 
15%. 

 
 

 

H 
 

holiday pay    An accrual of leave based on a 
percentage of the employees gross earnings. 
May be paid to casual employees or when 
preparing a final pay. 

 
 

 

 
 

F 
 

financial year  The 12‐month period you use 
to define your accounting year. MYOB Payroll 
works in the current financial year. 

 
Final Pay A person is given a final pay when 
they leave the organisation and their personal 
file is made inactive. 

I 
 

IR344    The Monthly schedule Amendments 
form required by Inland Revenue to amend 
schedules for previous months that have 
already been sent. 

 
IR345    The (bi)‐monthly return to Inland 
Revenue providing details of the tax payments 
made to Inland Revenue. Also see ir346. 

 
IR346    For organisations that pay SSCWT. The 
(bi)‐monthly return to Inland Revenue 
providing details of the tax payments made to 
Inland Revenue. Also see IR345. 
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IR348    The monthly Schedule to Inland 
Revenue providing details of all employee 
payments and tax deductions. This can also be 
filed electronically as an ir‐File. 

 
IRD Number    The Tax Number used by 
Inland Revenue to uniquely identify every 
taxpayer. 

 
IRD    Inland Revenue is the government 
department responsible for administering 
New Zealand's tax system; www.ird.govt.nz. 

 
ir‐File    The electronic return to Inland 
Revenue providing details of all employee 
payments and tax deductions. This can also be 
filed on a paper schedule: the ir348 form. 

Leave in Lieu    Leave given to a person in Lieu 
of payment for additional time worked, 
typically out‐of‐hours or on a public holiday. 

 
Leave Liability    The outstanding dollar value 
of some leave. 

 
Leave Taken    Leave that a person has used. 

 
Leave    An entitlement given to people 
allowing them to take time off work. 

(For leave‐related terms, see also the 
glossary on page 69) 

 
Liability account code    The credit side of 
payroll expense journals, usually the default 
payroll code set in Options > Integration tab, 
however can be any tax, deduction or 
payment pay code. 

 

 

 

J 
 

 

journals A transaction type. In MYOB 
Payroll, journals can be exported to an 
integrated GL program. 

N 
 

Net Pay    Gross Pay less Tax Deductions. 
 
 

 

 
 

L 
 

Large Employer (As defined by Inland 
Revenue)    An organisation that paid over 
$100,000 in tax payments in the previous tax 
year. A large organisation makes tax payments 
bi‐monthly. 

 
Leave Accrual    A calculation performed in 
every payroll that calculates the proportion of 
a leave entitlement that is currently due to a 
person. The entitlement accrues during the 
year and is given to the person on their leave 
anniversary. 

 
Leave Anniversary    The date when a person 
is given a leave entitlement. 

 
Leave Balance    The current amount of leave 
that a person has available to be taken. 

 
Leave Entitlement    A person's allocation of a 
particular type of leave. 

P 
 

Pay Day    The date that the payroll payments 
are available in people's bank accounts. 

 
PAYE    Income tax for salary and wage 
earners that is deducted by the organisation 
each payroll and paid to Inland Revenue. 

 
Payment    Money paid to a person, part of 
their Gross Pay. 

 
Payroll Letter of Credit    An agreement 
between the Organisation and its bank 
guaranteeing that payroll funds will be 
available for direct debiting under the Direct 
Debit Authority. 

 
Pay slip    Advice to a person providing a 
summary of their Payments, Deductions and 
other information for a pay period. 
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S 

 
Small Employer (As defined by Inland 
Revenue). An organisation that paid less 
than $100,000 in tax payments in the previous 
tax year. A small organisation makes tax 
payments monthly. 

 
SLD (Student Loan Deductions) Student 
Loan Deductions are loan repayments made 
to Inland Revenue by people who borrowed 
money to pay for their tertiary education. The 
repayments are on included in the Tax 
Remittance and Tax Schedule. 

 
Sick Leave    After working for an employer 
for a minimum of six months, you are entitled 
to at least five days paid Sick Leave. Sick Leave 
can be used for domestic leave (caring for 
spouse etc.). 

 
SSCWT    A tax deduction taken from a 
Superannuation Subsidy. 

Tax Deduction    A deduction made to Inland 
Revenue. This includes PAYE, SLD, CSD and WT. 

 
Tax Payment    Tax money paid to Inland 
Revenue, (as supported by a Tax Remittance). 

 
Tax Remittance    A schedule providing details 
of a tax payment to Inland Revenue. Printed 
on an IR 345 or IR 346 form. 

 
Tax Schedule    A monthly return to Inland 
Revenue providing details on individual 
person's tax deductions. Either printed on an 
IR 348 schedule or submitted as an ir‐File. 

 
Timesheet    The collection of individual 
payroll transactions for a person that 
determines the payments and deductions to 
be made. 

 
Transaction    An individual entry on a 
timesheet that describes the quantity, cost 
centre, rate and amount to be paid or 
deducted. 

 

statutory days    officially recognised days    
that employees are entitled to paid leave on, if 
it is a day they normally work. This is in 
addition to their annual leave entitlements. 

 
Superannuation Deduction    A deduction 
from a person's pay that is paid into a 
superannuation scheme. Also refer to 
Superannuation Subsidy. 

 
Superannuation Subsidy    A benefit, 
separate to a person's Gross Pay, that is paid 
by the into a superannuation scheme. 

 
 
 

T 
 

Take Home Pay    Gross pay less all 
deductions. 

 
Tax Arrears Outstanding money owed by a 
person to Inland Revenue. 

 
Tax Code    A code that determines what and 
how much tax is deducted. 

W 
 

WT    Withholding tax is deducted from 
payments to people who are not 
employees but work for the organisation 
on a contract‐for‐services basis. 

 
 

 

Y 
 

year end    The end of your payroll year, e.g. in 
NZ this is 31st March. 

 
 

 

Z 
 

zip file    A compressed file, that needs to be 
extracted before it can be used. 
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report 98 
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buttons: definition 14 
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overview 77 
frequency 78 
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checkboxes 
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Clear Defaults button 82 

Clearwater Ltd, tutorial example 
12 

columns 
changing order of 51 

command centres 
definition 13 
Maintenance 31 
Process Pays 87 

compulsory deductions 56 

consolidating payroll files 112 

contact details 
alternative 53 
next of kin 53 
your firm 21 

contract reference details 47 

converting 
existing payroll system 16 

cost analysis 
splitting between costcentres 

52 
using pay codes 40 

costcentres 32 
adding 33 
deleting 33 
maintaining 32 
split analysis 52 
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Current Employees report 98 
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protecting 27 
reindexing 108 
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Department List 98 

departments 
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